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Introduction

The RADIUS Extension Guide explains how to use the Solaris™ Extensions for
Netscape Directory Server 4.11 to authenticate users through the RADIUS protocol.
It also contains configuration information for the RADIUS service.

RADIUS Overview

The RADIUS server provided with Solaris Extensions for Netscape Directory Server
4.11 offers an authentication service for remote users. It also collects accounting
information on remote user connections.

Prerequisite Reading

For information on how to configure and manage the directory server and the
directory contents, refer to tidetscape Directory Server Administrator's Guidfer
basic directory and architectural concepts, refer tiNtecape Directory Server
Deployment Manual

Instructions for installing the Netscape Directory Server are contained in the
Netscape Directory Server Installation Guide

What Is in This Book?

This book explains how to configure and manage the RADIUS server provided with
Solaris Extensions for Netscape Directory Server 4.11. It is intended for system
administrators who are familiar with installing and configuring NAS devices and
RADIUS servers.

Introduction 13



Conventions Used in This Book

Conventions Used in This Book

Note

This section explains the conventions used in this book.

Monospaced font —This typeface is used for any text that appears on the
computer screen or text that you should type. It is also used for filenames, functions,
and examples.

Notes and Warnings mark important information. Make sure you read the information
before continuing with a task.

|—The vertical bar is used as a separator for user interface elements. For example,
Configuration|Logs means you should go to the Configuration tab on the Directory
Server Console and then select the Logs icon.

Throughout this book you will see path references of the form

<NSHOME>/slapd-<server|D>/...

In these situations;NSHOME»epresents the directory where you installed the
server, ancgserverID> represents the server identifier you gave the server when
you installed it. For example, if you installed your servéekport/ns-home

and gave the server an identifiempdfonebook , then the actual path would be

lexport/ns-home/slapd-phonebook/. . .

14 RADIUS Extension Guide



Chapter

Introducing RADIUS

This chapter contains background information about the RADIUS protocol and about
the RADIUS server provided with Solaris Extensions for Netscape Directory Server
4.11. For configuration information, refer to Chapter 2, “Initializing and Configuring
RADIUS.” For information on installing the RADIUS server refeSalaris

Extensions Installation Guide

This chapter contains the following sections:

» “RADIUS Authentication” on page 15

»  “RADIUS Accounting” on page 16

* “RADIUS Architecture” on page 17

* “Components Providing RADIUS Service” on page 18

RADIUS Authentication

The Remote Access Dialup User Service (RADIUS) protocol improves network
security by providing a mechanism for authenticating remote users connecting to the
network. It does this by carrying authentication, authorization and configuration
information between a Network Access Server (NAS) and a RADIUS server.

A NAS, also known as a Remote Access Server (RAS), is a device that provides an
access point to a network for remote users connecting through remote access
protocols such as telnet, ftp or PPP.

Chapter 1, Introducing RADIUS15



RADIUS Accounting

Figure 1.1 Network Access Server.

User

PPP telnet other

Network Access Server

Network

The configuration shown in Figure 1.1 relies on security mechanisms provided by the
connection protocol in use, for example PPP, to prevent unauthorized access to the
network. Using RADIUS, you can keep a single source of authentication information
in a directory and use it to authenticate remote users. The security mechanism is the
same regardless of the connection protocol.

RADIUS Accounting

You can also use the RADIUS server to collect information about remote user
connections. You can keep statistics on a per user basis.

A NAS can send accounting information about remote user connections to the
RADIUS server. This information is logged separately for each NAS, in a log file
calleddetail. Thedetail file is stored in a log directory called
Ivar/opt/SUNWconn/ldap/radacct/ nasname, wherenasnamés the value
of the common name (cn) attribute in the directory entry for the NAS.

If the RADIUS server is unable to authenticate the NAS, accounting information is
nonetheless logged, although it is markedragerified in thenasname/detail
file.

All the accounting information provided by the NAS is logged indibi@il ~ file.

16 RADIUS Extension Guide



RADIUS Architecture

Some accounting information can also be stored dynamically in the remote user’s
directory entry: it is added when the user connects, and deleted when the user
disconnects.

To configure the RADIUS server to log dynamic accounting information, refer to
“Configuring Dynamic Accounting” on page 36.

RADIUS Architecture

When RADIUS is in use, the authentication architecture is shown in Figure 1.2.

Figure 1.2 RADIUS Authentication Architecture

PPP telnet other Extranet

Network Access Servef

Intranet

{} RADIUS

RADIUS
server

LDAP
database

< O

A user is any entity requesting access to network resources. Each user is identified by
a unigque uid in the LDAP directory database.

The NAS, also referred to as the RADIUS client, is the device to which remote users
connect. The client queries the RADIUS server for authentication status, user profiles
and authorizations. In the directory database, each client is identified by a unique
ipHostNumber. The ipHostNumber attribute, and all other attributes describing a
RADIUS client are defined in the nas object class.

Chapter 1, Introducing RADIUS17



Components Providing RADIUS Service

The RADIUS server authenticates the NAS, then checks the remote user’s identity
and authorization in the directory database. It returns the user’s status (connection
authorized or refused) and configuration information to the NAS.

If the RADIUS server is unable to authenticate the NAS, the request from the NAS is
ignored. The RADIUS server does not respond, not even with a connection rejection.

Components Providing RADIUS Service

This section describes the components supplied with Solaris Extensions for Netscape
Directory Server 4.11 to provide the RADIUS service.

RADIUS Daemon

The RADIUS daemorgsradiusd , is the RADIUS server. It handles connection
requests received from NAS devices. It connects to the directory server daemon,
ns-slapd , to search for NAS and remote user information. It checks the
information held in the directory against the information supplied in the connection
request from the remote user. If the information supplied in the connection request is
valid, it returns an accept-connection response that can include the connection
parameters.

See “dsradiusd” on page 128 for more information on the RADIUS server daemon.

RADIUS Configuration Files

The configuration of the RADIUS server is mainly stored in éiseadiusd.conf
file. However, some configuration parameters are stored irathes.mapping
file.

See “Configuring RADIUS” on page 23 for details on the configuration parameters.

18 RADIUS Extension Guide



Components Providing RADIUS Service

RADIUS Schema Objects

RADIUS-specific object classes and attributes are required to support the RADIUS
server, in particular to store information about NAS devices and remote users in the
LDAP directory.

The RADIUS-specific LDAP attributes are mapped onto the RADIUS attributes that
are actually used in the communications between the NAS and the RADIUS server.
This mapping is defined in thradius.mapping file.

For information on RADIUS schema objects, see “RADIUS Schema” on page 91.

RADIUS Console

The RADIUS Console is a graphical tool that offers a friendly way of performing
RADIUS administration and configuration tasks. It is integrated in the Netscape
management framework. An icon representing the RADIUS console is listed under
the Server Group subtree in the Netscape Console.

For information on starting the RADIUS Console, see “Configuring RADIUS” on
page 23.

PAM Module

You can use the plugable authentication module (PAM) to offer authentication
mechanisms such as Kerberos, RSA or smart cards on top of RADIUS. The PAM
module is part of the Solaris operating system.

For general information on the PAM authentication modules and API, refer to the
pam(3) man page. For information on configuring PAM authentication modules,
refer to thepam.conf(4)  man page.

For information on configuring the RADIUS server to operate with the PAM module,
refer to “Configuring RADIUS to Use PAM” on page 42.

Chapter 1, Introducing RADIUS19
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Chapter

Initializing and Configuring RADIUS

This chapter explains how to start using RADIUS with the Netscape Directory
Server. It explains the initialization process and the configuration tasks you can
perform.

This chapter includes the following sections:

» ‘“Initializing RADIUS” on page 21

» “Configuring RADIUS” on page 23

« “Advanced Configuration of RADIUS Searches” on page 27
* “RADIUS Server Statistics” on page 39

* “Configuring RADIUS to Use PAM” on page 42

Initializing RADIUS

When you initialize the RADIUS server, both authentication and accounting are
enabled. There are two separdseadiusd processes for authentication and
accounting.

A setup scriptsetup_rad , guides you through the initialization process. The
setup_rad script performs the following tasks:

» Registers the RADIUS console with the Netscape Console by updating the
information in the configuration directory

Chapter 2, Initializing and Configuring RADIUS1



Initializing RADIUS

Configures RADIUS for use with the LDAP directory server by updating
information in the user directory

Depending on how you set up your Netscape Directory Server, configuration
information and user information is not necessarily stored in the same LDAP
database. Theetup_rad script takes this into account.

You will need to understand and prepare the information you must supply to the
setup_rad script. The script prompts you for:

1.

22 RADIUS Extension Guide

The full name of the machine on which you will run the RADIUS server
The format ishostnamalomainName

The LDAP URL for the configuration directory.

This is the URL to the directory that holds the configuration information. It is not
necessarily the same as the directory that holds user information. The format of
the URL is Idap:HostnamalomainNamgportNumbet.

The installation directory for the Netscape Directory Server.

The DN of the directory manager for the Netscape Directory Server.

The DN you provide must be the same as the one you provided in the setup script
for the Netscape Directory Server. This DN has all permissions on the Netscape
Directory Server. By default, it is cn=Directory Manager.

The password of the directory manager for Netscape Directory Server.
The name of the administration domain managed by the server.

The LDAP URL for the user directory.

If you use the same directory to hold configuration information and user
information, this URL is the same as the one you supplied earlier.

The password and DN of the directory manager for the user directory if different
from the configuration directory.

The DN of the subtree under which the RADIUS server must perform searches for
remote user and NAS authentication.



Configuring RADIUS

To initialize RADIUS, follow these steps:

1. Make sure that thEUNWdsrad andSUNWdsutl packages are installed. For
example, type:

% pkginfo SUNWdsrad SUNW(dsutl

This command should return the name and description of the packages. If you
need to install the packages, refeBtaris Extensions Installation Guide

2. Make sure that the directory server daemssslapd  and the admin server
daemoms-admin are running. For example, type:

% ps -ef | grep ns-

The listing returned by this command should contain the following lines:

root 8371 1 016:03:13? 0:00 ./ns-admin -d
lusr/netscape/server4/admin-serv/config

root 8375 1 016:03:427? 0:05 ./ns-slapd -f
lusr/netscape/server4/slapd-faerie/config/slapd.conf -i /usr/nets

If it doesn’t you must start thes-slapd  daemon, as explained in tNetscape
Directory Server Administrator's Guide

3. Run the RADIUS setup scripgetup_rad . Asroot , type:

# lopt/SUNWconn/ldap/sbin/setup_rad

4. Start the Netscape Console.

5. In the left pane of the Console, browse down the tree to the RADIUS server, and
double click on the icon to open the RADIUS console.

6. Inthe RADIUS console window, from the Task tab, select Start RADIUS Server.

Your RADIUS server is initialized and configured. If you want to change
configuration parameters at any time, refer to “Configuring RADIUS” on page 23.

Configuring RADIUS

The RADIUS service can be configured in two ways:

* From the RADIUS console
» By editing the configuration filemdius.mapping , anddsradiusd.conf
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Starting the RADIUS Console
To start the RADIUS console:
1. Start the Netscape Console.

2. Inthe left pane of the Console, browse down the tree to the RADIUS server, and
double click on the icon to open the RADIUS console.

The RADIUS console is displayed
To access the main configuration panel, in the RADIUS tree view on the left, select

Common, then click the Configuration tab. The configuration panel contains fields for
all the parameters described in “Editing RADIUS Configuration Files” on page 24.

Information on how to perform advanced configuration tasks from the RADIUS
console is provided with each task description in this chapter.

Editing RADIUS Configuration Files

The RADIUS configuration is stored in the following files:
» /etc/opt/SUNWconn/Idap/current/mapping/radius.mapping
» /etc/opt/SUNWconn/Idap/current/dsradiusd.conf

Note When you modify the RADIUS configuration by editing one of these files, you must
restart or refresh the RADIUS daemon. You can do this from the Tasks tab on the
RADIUS console.

radius.mapping file
The following configuration parameters are defined inréttius.mapping file:

» Max_allowed_failures

This parameter determines blocking mode. It defines the number of permitted
consecutive failures to authenticate a user based on the password provided. Any
further attempt is systematically blocked, even if the connection parameters
supplied are correct. The count is reset on first success. The default value for this
parameter ig. To disable blocking mode, set this parameté. to

When a user account is blocked, you must manually enable it again by setting the
authFailedAccess attribute in the remote user’s entry to zero.
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» Dynamic

This parameter determines whether dynamic accounting data is recorded in the
LDAP directory (see “Configuring Dynamic Accounting” on page 36). It can have
one of two valuen or off. By default, dynamic accountingagf.

» Authentication_Port

The authentication port number for RADIUS processes. The default port number
is 1645 Due to later standardization, the standard port numi@&1i® This port
number is defined in thadius.mapping file but is commented out.

» Accounting_Port

The accounting port number for RADIUS processes. The default port number is
1646 Due to later standardization, the standard port numi@&1i3 This port
number is defined in thedius.mapping file but is commented out.

e Acounting_dir

The directory where accounting information is stored. The default directory is
Ivar/lopt/SUNWconn/ldap/radacct . Note that there is a typographical
error in this variable in theadius.mapping  file. Do not correct it because the
RADIUS server would be unable to read it.

* Max_wait_b4 reject

This parameter defines a client timeout on a RADIUS request. It determines the
maximum time a client will wait for a response from the RADIUS server. By
default it is58 seconds.

e Time_limit

This parameter defines a RADIUS server timeout on LDAP search operations. It
must bestrictly less tharthe value of thdax_wait_b4 reject parameter.
By default it is50 seconds.

Blocking mode and dynamic accounting settings are not taken into account when the
RADIUS search is performed on a referral server.

Whenever you modify theadius.mapping file, you must run thelejasync
utility to copy the modifications you made to theja.properties file. Your
modifications will not be reflected in Deja if you don'’t wsjasync
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dsradiusd.conf file

The following configuration parameters are definedsradiusd.conf
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The hostname for the LDAP server

This parameter is stored in th&®AP_Server configuration variable. Its default
value islocalhost

The TCP port number that the LDAP server runs on

This parameter is stored in thBAP_Port configuration variable. Its default
value is389.

The DN used to bind to the LDAP directory for performing searches and
modifying the LDAP database

This parameter is stored in thBAP_Bind_dn configuration variable. A
placeholder value afn=radiusadmin is provided as an example.

The password used to bind to the LDAP directory for performing searches and
modifying the LDAP database

This parameter is stored in the LDAP_Password configuration variable. A
placeholder value afecretis provided as an example.

The log level

This parameter is stored in the@glLevel configuration variable. You can select
one of the following log levels:

¢ 0=none

e 1 =trace

e 2 =trace and translation

e 3 =trace, translation, and other debug information

The default i<.

The number of kilobytes before the log file automatically changes over to the next
log file.

This parameter is stored in th®gSize configuration variable. Its default value

is 1000

The log directory wherdsradius.log is located

This parameter is stored in thegDir configuration variable. Its default value is
Ivar/opt/SUNWconn/ldap/log



Advanced Configuration of RADIUS Searches

Advanced Configuration of RADIUS Searches

Note

You can perform the following advanced configuration tasks:

» Provide temporary access to a remote user whose entry is not in the subtree
normally searched to find users

» Associate remote users with a particular NAS, and grant access through that NAS
only

» Combine the options above to provide temporary access through a specified NAS
* Manage remote users connecting from a virtual domain

These tasks are performed by modifying the DN and the search filters that the
RADIUS server uses to do searches in the directory.

The subtrees searched by the RADIUS server are specified in the
radius.mapping file by theBaseDN variable. TheBaseDN variable for remote
usersis located in the Common section under the USERS tabl®&ageDN variable
for NAS devices is located in the Common section under the RAS table.

For example, in the Common section of the Users tabl&akeDN is similar to:

BaseDN= o=airius, c=us
The actual value of this attribute is supplied duringsiételp_rad  process.

The object classes and attributes that are used in RADIUS searches are specified in
the mapping file by thEILTER variable. TheFILTER variable for remote users is
located in the Dynamic section under the USERS tableFIHEER variable for

NAS devices is located in the Dynamic section under the RAS table.

For example, in the Dynamic section of the USERS tabld; HHEER is:

FILTER=(&(Objectclass=remoteUser)(uid=$UserID))

In these examples, the RADIUS server searches for the userid passed in the request
from the NAS in the subtree o=airius, c=us among all entries with an object class of
remoteUser.

The syntax of filters is described in RFC 225% String Representation of LDAP
Search Filters
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Providing Temporary Access to Users

The basic configuration for RADIUS searches on remote users is defined in the
radius.mapping file, under the USERS table. The variables that define the search
criteria are:

BaseDN= search_base

FILTER=(&(Objectclass=remoteUser)(uid=$UserID))

Where:

search_basés the subtree that is searched for entries with the remoteUser object
class.

$UserlD represents the actual userid passed in the request from the NAS.

Without changing your basic configuration, you can allow temporary access to a
remote user whose entry is in a different subtree.

Editing the Mapping File

1. Inthe USERS table, addBaseDNandFILTER token to the configuration with
the prefixTMP_, and assign temporary values, using the following format:

TMP_BaseDN = new_search_base

TMP_FILTER = (&(Objectclass=remoteUser)(uid=$UserID)(uid= userid ))

where:

new_search_base the subtree that holds the remoteUser entry for the person to
whom you are granting temporary access. If this subtree is stored on a different
server, ensure that a referral is defined between the two servers

useridis the actual userid of the remote user. This ensures that you grant access to
that user alone, and not to all the entries with the object class remoteUser in the
new search base

2. Restart thelsradiusd daemon so that the new configuration file is taken into
account. Agoot , type the following commmands:

# lopt/SUNWconn/ldap/sbin/dsradius stop
# lopt/SUNWconn/ldap/sbin/dsradius start
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For example, if your Base DN for remote users is |=Paris, o=airius, c=US, and you
want to provide temporary access to the remote user Felipe Gonzalez located in
Madrid, you would change the loaaldius.mapping file to include:

BaseDN= |=Paris, o=airius, c=us

TMP_BaseDN= |=Madrid, o=airius, c=us
FILTER=(&(Objectclass=remoteUser)(uid=$UserID))
TMP_FILTER=(&(Objectclass=remoteUser)(uid=$UserID)(uid=fgonzalez))

This example assumes that a referral exists between the local directory server and the
directory server holding the subtree I=Madrid, o=airius, c=US.

If you want to temporarily extend permission to all remote users within the Airius
corporation, you would use the following temporary base DN variable:

TMP_BaseDN= o=airius, c=us

This example assumes that there is a default referral from the server that holds the
I=Paris, o=airius, c=us subtree to the server that holds the o=airius, c=us subtree. It
also assumes that the o=airius, c=us subtree contains referral entries to all subtrees
held on other servers.

Using the RADIUS Console

To perform the same operation from the RADIUS console:

1. Inthe RADIUS tree view on the left, select Users, then select the Configuration |
Common tab.

2. Add aTMP_BaseDNvariable. Do not remove the curré@dseDN variable.
3. Select the Configuration | Dynamic tab.
4. Add aTMP_FILTER variable . Do not remove the curréit TER variable.
5. Select the Tasks tab and click Refresh.

For details about thEMP_BaseDNandTMP_FILTER variables, refer to “Editing
the Mapping File” on page 28.
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Restricting Access through a Specified NAS

You may want to ensure that remote users always connect to a specific NAS. For
example, if you want to control communications costs, you can ensure they connect to
the NAS that is geographically closest to them.

The basic configuration for RADIUS searches on NAS devices is defined in the
radius.mapping file, under the RAS table. The variables that define the search
criteria are:

BaseDN= search_base

FILTER=(&(Objectclass=remoteUser)(uid=$UserID))

Editing the Mapping File

1. Inthe USERS table, addBaseDNandFILTER token to the configuration with
the suffix_nasnamgand assign temporary values.

BASEDNnasname= search_base

FILTER_ nasname = (&(Objectclass=remoteUser)(uid=$UserID))
where:

« search_bases the subtree that holds the directory entries for the remote users
to whom you are granting access through the NAS

¢ nashamas the name of the NAS (value of the cn attribute in the directory
entry for the NAS) through which you are granting access

For information on the order in which these lines are processed during a RADIUS
search, refer to “Processing Order for RADIUS Search Parameters” on page 33.

2. Restart thelsradiusd daemon so that the new configuration file is taken into
account. Agoot , type the following commmands:

# lopt/SUNWconn/ldap/sbin/dsradius stop
# lopt/SUNWconn/ldap/sbin/dsradius start

For example, your Base DN for remote users is I=France, o=airius, c=us, and you
have remote users located in Paris, Lyon, and Toulouse who can connect to the
network through a local NAS at each site. The NAS names are ParisNAS, LyonNAS,
and ToulouseNAS, respectively. You want to ensure that remote users always connect
through the nearest NAS to save on communication costs.
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You would change thedius.mapping file to include:
BaseDN= |=France, o=airius, c=us

BaseDN_ParisNAS= I=Paris, I=France, o=airius, c=us
BaseDN_LyonNAS= I=Lyon, I=France, o=airius, c=us
BaseDN_ToulouseNAS= I=Toulouse, |=France, o=airius, c=us

FILTER=(&(Objectclass=remoteUser)(uid=$UserID))

When the RADIUS server receives a request from ParisNAS, it checks that the remote
user belongs to the naming context I=Paris, I=France, o=airius, c=us.

Using the RADIUS Console

To perform the same operation from the RADIUS console:

1. Inthe RADIUS tree view on the left, select NAS, then select the Configuration |
Common tab.

2. Add aBaseDN_nasnamevariable. Do not remove the currédseDN variable.

nasnamas the name of the NAS (value of the cn attribute in the directory entry
for the NAS) through which you are granting access.

3. Select the Configuration | Dynamic tab.

4. Add aFILTER_ nasnamevariable. Do not remove the currddit TER variable.

nasnamas the name of the NAS (value of the cn attribute in the directory entry
for the NAS) through which you are granting access.

5. Select the Tasks tab and click Refresh.

For details about thBaseDN_nasnameandFILTER _nasnamevariables, refer to
“Editing the Mapping File” on page 30.

Combining Temporary Access and NAS
Restriction

You can combine temporary access permissiotirestrict access to a particular NAS
by combining thefMP_prefix and_nasnamesuffix on theBaseDN or theFILTER
tokens.
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For example, if you want to grant Felipe Gonzalez from Madrid remote access to the
Paris NAS just for the duration of a business trip to Paris, you would modify the
radius.mapping file to include the following lines in the Dynamic section of the
USERS table:

BaseDN= |=France, o=airius, c=us

TMP_BaseDN= |=Madrid, o=airius, c=us
FILTER=(&(Objectclass=remoteUser)(uid=$UserID))
TMP_FILTER_ParisNAS=(&(Objectclass=remoteUser)(uid=$UserID)(uid=fgonzal

ez))

In this example, thenasnameuffix is added to the temporary filter rather than to the
temporary base DN. The reason is that you may want to grant other people from the
Madrid office access through a different NAS from the Paris NAS. In this case, the
temporary base DN remains valid, you just need to create the temporary filter with the
appropriate_nasnamesuffix.

Managing Virtual Domains

You can manage remote user connections from users who belong to a virtual domain,
that is, a domain that you manage on behalf of another organization.

For example, if ABC corporation decided to use ISP corporation to manage their
internet mail service, ABC would be assigned a domain name such as abc.com, and a
pool of IP addresses. ISP corporation manages user information, and remote user
connections for ABC corporation. When an employee from ABC corporation

connects to request remote access, the connection parameters are the user login and
the user password.

For example, John Smith logs in with the following parameters:
* Login: jsmith@abc.com
* Password: secret

The RADIUS server of ISP corporation needs to separate the user ID from the domain
information. This is done in thadius.mapping file. The beginning of the
USERS table and the variables defined in the Dynamic section would be as follows:
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Table: USERS
Common:
BaseDN= o=isp, c=us
Dynamic
userID=>$myID@$%$virtualDomainT || $myID
FILTER=(&(Objectclass=remoteUser)(uid=$myID))
In this configuration example, theserlD variable accepts two alternative

expressions so that it can handle equally well remote users who have a domain name
appended to their user ID, and those who do not.

The domain name must be checked during the authentication procedure, therefore the
directory entry of John Smith includes these attributes:

e uid: jsmith

» userPassword: * (protected)

» authSuffixName: @abc.com

e grpCheckinfo: userPassword, authSuffixName

The grpCheckinfo attribute gives the list of attributes that must be supplied in the
authentication procedure. The RADIUS server checks the values provided for these
attributes against the values stored in the directory database.

Processing Order for RADIUS Search
Parameters

During a search, the RADIUS server handlesBlaseDN andFILTER tokens in the
following manner: it first performs an ordinary search, then, if this search fails, it
performs a search on temporary tokens.

The ordinary search starts from the most restrictive to the most general:
1. FILTER_nasname

2. FILTER

3. BaseDN_nasnhame

4. BaseDN
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If the ordinary search fails, the temporary search is handled in the same way:
1. TMP_FILTER_nasname

2. TMP_FILTER

3. TMP_BaseDN nasname

4. TMP_BaseDN

Specifying a Dictionary File

The RADIUS server uses a dictionary file to convert numerical values used by the
protocol to attribute names used in tfaelius.mapping  file and the RADIUS log
files. The dictionary file contains RADIUS attribute and numerical value pairs. A
number of these attributes are defined in RFC R&8ote Authentication Dial In
User Service (RADIUSaNd RFC 213RADIUS AccountingHowever, NAS vendors
have also defined proprietary attributes, referred to as vendor-specific attributes or
VSAs.

Do not confuse the RADIUS dictionary file with the RADIUS mapping file which
provides a translation between RADIUS attributes and LDAP attributes. For
information on the RADIUS mapping file, refer to Chapter 4, “RADIUS/LDAP
Information Mapping.”

Solaris Extensions for Netscape Directory Server 4.11 provide a default dictionary
that contains the standard attribute and value definitions. It also accepts the
dictionaries from the following vendors:

e Livingston

 Ascend
» Cisco
e Shiva

e Bay Networks

The dictionary files provided by vendors contain both standard and proprietary
definitions. Attribute and value definitions are identified by an OID which is the
actual information passed in a RADIUS transaction. Due to a lack of standardization
some proprietary attributes defined by different vendors use the same OID.
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The RADIUS server can support any number of dictionary files from different
vendors, but you must specify which dictionary to use with a particular NAS.

To specify a dictionary file for a NAS, use the Deja tool to add the dictionaryFile
attribute to the directory entry for the NAS. The value you assign to this attribute must
be the filename of the dictionary that the RADIUS server must use for
communications with the NAS described by the entry.

If the dictionaryFile attribute is not specified, the default dictionary file is used. This
file, calleddictionary , is located with all other configuration files under
letc/lopt/SUNWconn/Idap/current

If you use the dictionary provided by the NAS vendor instead of the default dictionary
provided with Solaris Extensions for Netscape Directory Server 4.11, you must copy
the attributes used internally by the RADIUS server from the default dictionary to the
vendor-supplied dictionary. The list of attributes that you must copy is shown in the
following file extract.

Table 2.1 RADIUS Server Internal Attributes

# Non-Protocol Attributes
# These attributes are used internally by the server

#

ATTRIBUTE Expiration 21 date
ATTRIBUTE Auth-Type 1000 integer
ATTRIBUTE Menu 1001 string
ATTRIBUTE Termination-Menu 1002 string
ATTRIBUTE Prefix 1003 string
ATTRIBUTE Suffix 1004 string
ATTRIBUTE Group 1005 string
ATTRIBUTE Crypt-Password 1006 string
ATTRIBUTE Connect-Rate 1007 integer
#

# SUN RADIUS Attributes for LDAP Integration

#

ATTRIBUTE Login-Profile 2000 integer
ATTRIBUTE Login-Passwd 2001 string

ATTRIBUTE Login-Expiration 2002 date
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# Non-Protocol Attributes

ATTRIBUTE PPP-Profile 2010 integer
ATTRIBUTE PPP-Passwd 2011 string
ATTRIBUTE PPP-Expiration 2012 date
ATTRIBUTE SLIP-Profile 2020 integer
ATTRIBUTE SLIP-Passwd 2021 string

ATTRIBUTE SLIP-Expiration 2022 date
ATTRIBUTE Auth-Failed-Access 2100 integer
ATTRIBUTE Dynamic-Session-Counter 2201 integer
ATTRIBUTE Dynamic-Sessionld 2202 string
ATTRIBUTE Dynamic-IPAddress 2203 ipaddr
ATTRIBUTE Dynamic-IPAddr-Binding 2204 string
ATTRIBUTE PAM-Service-Name 2205 string

Configuring Dynamic Accounting

You can use the RADIUS server to record connection parameters dynamically in the
directory entry of a remote user. To enable dynamic accounting, in the RADIUS
Console, set the Dynamic Data option to On.

With dynamic accounting enabled, the following attributes are automatically added to
a remote user’s entry when the user connects, and removed when the user
disconnects:
» Dynamic IP address:

The IP address assigned to the remote user connection

* Dynamic session ID
The accounting session ID assigned to a remote user for a given session

» Dynamic session counter
The number of concurrent open sessions

« Dynamic IP address binding

The association between the IP address and the accounting session ID for a given
session
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» All other RADIUS attributes listed in the accounting file

When a remote user has several open sessions, the dynamic session counter attribute
is removed from the user’s entry when the user has closed all running sessions.

A default accounting file is provided with Solaris Extensions for Netscape Directory
Server 4.11, calledcctattr . You can, if you want, create your own dynamic
accounting file. The only requirement is that the file name should end wigttthe
suffix.

You must make sure that the NAS can provide the accounting parameters listed in the
accounting file. This file should be located with other configuration files in
/etc/opt/SUNWconn/ldap/current

The dynamic accounting parameters listed in the defadtattr  file are RADIUS
attributes that can be contained in RADIUS accounting packets. The corresponding
LDAP attributes are shown in Table 4.1.

The defaullacctattr  file contains examples of suitable RADIUS attributes
commented out. These are:

e Framed-IP-Address
e Acct-Session-Id

«  NAS-Port

* NAS-Port-Type

e NAS-IP-Address

If you want to add accounting items to the list, ensure that:
1. At least one NAS can provide these items in an accounting packet.

2. There is an LDAP attribute for each RADIUS parameter that you want to record.
If there isn’t, you must create the corresponding LDAP attribute, as explained in
“Creating a Dynamic Accounting Attribute” on page 38.

3. The mapping between the RADIUS attribute and the LDAP attribute is defined in
theradius.mapping file.

If it isn’t, you must create it as described in “Creating a Dynamic Accounting
Attribute” on page 38.
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Creating a Dynamic Accounting Attribute

To create a dynamic accounting attribute, and the RADIUS/LDAP mapping
definition:

1. Create an LDAP attribute for the connection parameter that you want to record.

This is a modification of the Netscape Directory Server schema. For information
on how to create new attributes in the directory server schema, refer to the
Netscape Directory Server Administrator's Guide

2. Add the attribute to the list in thradius.mapping file using a text editor.

Make sure you add it in both the Import section and the Export section of the
mapping file. You need to be logged inrast to perform this operation.

Alternatively, you can add the attribute from the RADIUS console: In the
RADIUS tree view on the left, select Users, then select the Configuration | Import
tab. Add the attribute in the Import section of thdius.mapping file. Then
select the Configuration | Export tab to add the attribute to the Export section

3. Add the attribute to the list in the accounting file using a text editor.

You need to be logged in esot  to perform this operation.

Alternatively, you can add the attribute from the RADIUS console: In the
RADIUS tree view on the left, select Users, then select the Configuration |
Accounting tab. Select the accounting file that you want to modify and click Load.

4. Restartthes-slapd daemon so that the new accounting attribute created in the
schema is taken into account and can be recorded dynamically in remote user
entries.

5. Restart thelsradiusd daemon so that the neadius.mapping file is
taken into account.

To do this from the RADIUS console, from the Tasks tab, select Refresh.

Specifying an Accounting File for a NAS

To specify an accounting file for a NAS, use the Deja tool to add the acctattrFile
attribute to the directory entry for the NAS. The value you assign to this attribute must
be the filename of the dynamic accounting attribute file that the RADIUS server uses
to record the dynamic accounting information received from the NAS.

38 RADIUS Extension Guide



RADIUS Server Statistics

If the acctattrFile attribute is not specified, the defaatttattr  file is used. This
file is located with all other configuration files under
letc/opt/SUNWconn/Idap/current

ACLs on RADIUS Information

RADIUS information in the LDAP directory is protected by a special ACI. The
instruction specifies a filter for the RADIUS object classes, the list of RADIUS
attributes to which the instruction applies, a name for the instruction, the permission
level, and the LDAP URL used by the RADIUS server to perform searches and
modifications in the LDAP directory.

The default ACI on RADIUS information is shown below.
# SUN Radius Attribute Control Item

#

aci:

(targetfilter="(|(objectclass=nas)(objectclass=remoteUser))")
(targetattr="*")

(version 3.0;aci "Radius User permissions"; allow(all)
userdn="ldap:///cn=radiusAdmin,o=sun.com";)

Note Note that the default ACI gives the RADIUS administrator all permissions on all
attributes fargetattr="*" ). You can if you want, restrict the attributes which
the RADIUS administrator can access by listing them in the ACI. If you modify the
default ACI, make sure that your list of attributes contains at least the userPassword
attribute.

RADIUS Server Statistics

This section lists the information collected by the RADIUS server SNMP agent
dsnmprad . This information can be monitored from a management platform such as
Solstice™ Enterprise Manager™, Solstice Site Manager™, or Solstice Domain
Manager™.,
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Information Collected

The information collected by trdsnmprad SNMP agent is defined in RFC 2619
RADIUS Authentication Server Mihd RFC 262RADIUS Accounting Server MIB

The following RADIUS authentication service information is monitored:

» Server identifier

» Uptime

* Resettime

» Configuration reset

» Total access requests

» Total invalid requests

» Total duplicate access requests
» Total access accepts

» Total access rejects

» Total access challenges

» Total malformed access requests
» Total bad authenticators

» Total packets dropped

» Total unknown type

» Client entry (contains authentication information monitored for every NAS
connected to the server)

e Client Index

¢ Client Address

e ClientID

e Access requests

« Duplicate access requests
e Access accepts

e Access rejects

e Access challenges

« Malformed access requests
« Bad authenticators

« Packets dropped

¢ Unknown type
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The following RADIUS accounting service information is monitored:

* NAS identifier

» Uptime

* Resettime

« Configuration reset

» Total requests

» Total invalid requests

« Total duplicate requests
» Total responses

» Total malformed requests
» Total bad authenticators
» Total packets dropped

» Total no record

e Total unknown type

» Client entry (contains accounting information monitored for every NAS
connected to the server)

¢ Client Index

e Client Address

e ClientID

e Packets dropped

* Requests

¢ Duplicate requests
* Responses

« Bad authenticators
« Malformed requests
¢ No record

¢ Unknown type
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Displaying RADIUS Server Statistics

You cannot display RADIUS server statistics in the RADIUS console. You need a
management application such as Solstice Enterprise Manager, Solstice Domain
Manager, or Solstice Site Manager. The files required to interoperate with these
management applications are provided with Solaris Extensions for Netscape
Directory Server 4.11.:

» The directoryopt/SUNWconn/ldap/snmp/snm contains all files necessary
for dsnmprad to report events to a Solstice Domain Manager, or Solstice Site
Manager station

» The directoryopt/SUNWconn/Ildap/snmp/sem contains all files necessary
for dsnmprad to report events to a Solstice Enterprise Manager station.

Configuring RADIUS to Use PAM

This section describes how to enable PAM on top of the RADIUS server. The
procedure given in this section is based on a sample PAM plug-in provided in the
directory/opt/SUNWconn/ldap/samples/pam . This example PAM module

can be used by the RADIUS server to authenticate, authorize and perform accounting
for remote users.

1. Change directory to thlept/SUNWconn/Idap/samples/pam directory.

2. Make the PAM module by typingnake in this directory. Ignore the warning
messages displayed at the end ofrtiade process.

3. Copy the PAM modul@am_sample.so.1  to/ust/lib/security/ and
make sure it is owned bgot .

4. Inthe RADIUS console, go to the main configuration panel and enable the use of
PAM: check the PAM enabled checkbox, and specify a challenge reponse timeout
in the Challenge/Resp Timeourt field. A reasonable val@8.is

Alternatively, you can edit theadius.mapping file in the directory
letc/lopt/SUNWconn/Idap/current/mapping/ to add the following
lines to the Common section:

Pam_Authentication=on
Challenge_Response_Timeout=60
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5. Modify the/etc/pam.conf configuration file to include the following lines:

# Radius

radius auth required /ustr/lib/security/pam_sample.so.1

radius account required lusr/lib/security/pam_sample.so.1

radius session required lusr/lib/security/pam_sample.so.1

radius password required Just/lib/security/pam_sample.so.1

6. Modify the entries of remote users in the directory to include the following
attributes and values:
pamServiceNameadius
grpCheckinfopamServiceName

The pamServiceName attribute specifies the name of the PAM module to use in
letc/pam.conf . The grpCheckinfo attribute usually also contains the
userPassword attribute. If you remove userPassword, then only PAM
authentication is used.

7. Restart thelsradiusd daemon so that the neadius.mapping file is
taken into account.

To do this from the RADIUS console, from the Tasks tab, select Refresh.
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Chapter

Using Deja to Update RADIUS
Information

This chapter explains how to use the Deja tool to add, delete and modify RADIUS
information in the LDAP directory. Solaris Extensions for Netscape Directory Server
4.11 provides several graphical interfaces to view or modify information in the
directory:

» The Directory Console
* The Directory Express web gateway
* Deja

The Directory Console can be used to create and modify most information in the
directory but it does not offer dedicated templates for creating and modifying
RADIUS information.

The Directory Express web gateway is designed for viewing the contents of the
directory quickly, searching for entries, and modifying some directory information.
Its limited functionality makes it unsuitable for more complex operations.

Dejais a Java™ directory editor particularly suited for the day-to-day management of
RADIUS information. With the tool you can search for and view entries, create and
modify entries, delete entries, and copy and paste entries. Deja can be connected
remotely or locally to a Netscape Directory Server.

This chapter includes the following sections:

e ‘“Introduction to Deja” on page 46
* “General Operations” on page 51
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» “Operations on RADIUS Entries” on page 54
e “Setting Deja Properties” on page 76

Introduction to Deja

Deja provides a comprehensive user interface suitable for maintaining the directory
contents. Figure 3.1 shows the Deja Create panel. The tool is split into four areas, the
toolbar, the browser window, the function window, and the status bar. The toolbar,
browser window, and status bar can be hidden.

When you click on an icon in the toolbar or select an option from the Directory menu,
the appropriate screen is displayed in the function window.

File ©Options  Edit Entry Help |
i s 8 o=l nn g | ) B
|dap://faerie;389 q

@ o=Sun.COM ’._
@ o=NetscapeRoot i

Directory
Editor

Deja

wealcome to Dejal

Figure 3.1 Deja Directory Editor

The toolbar offers quick access to the most commonly used functions. Refer to
Table 3.1 for a description of the icons and their functions.
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Table 3.1 Deja Toolbar Icons

this icon to view the entry’s attributes and values.

Click this icon to create a new entry in the directory.

Select an entry in the directory browser window and ¢
this icon to modify the entry’s properties.

Icon Function
Login Click this icon to login to the directory server. You muist
login to modify the contents of the directory.
8 =]
e
Search Click this icon to search for entries in the directory.
e |
l «E}
View Select an entry in the directory browser window and ¢

lick

lick

i) = ® 1:!'

Select an entry in the directory browser window and ¢
this icon to modify the Relative Distinguished Name
the entry.

lick
of

Delete

=i

Select an entry in the directory browser window and ¢
this icon to remove an entry from the directory.

lick
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Icon

Function

Cut

s

copy in the clipboard.

Select an entry in the directory browser window and dlick
this icon to cut the entry from the directory, and retain a

Copy

6

this icon to copy the entry into the clipboard.

Select an entry in the directory browser window and dlick

Paste

2

entry

After an entry has been cut or copied to the clipboard,
select a parent entry in the directory browser window and
click this icon to paste the entry as a child of the selected

Help

&

Click this icon to display the online help.

Starting Deja

Deja must connect to the directory server. This connection can be established only if
thens-slapd daemon is running on the directory server. If tiseslapd daemon
is not running, Deja will start but is unable to connect.

For information on starting the Netscape Directory Server, selétscape Directory
Server Administrator's Guide

To display Deja:

1. Run thedejasync

utility. As root type:

# lopt/SUNWconn/ldap/sbin/dejasync

For details on the options of thejasync command, refer to “dejasync” on
page 121. You must rugejasync  so that Deja will take into account all the
configuration options you set during thetup_rad process.
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2. On the machine running the directory server daemsislapd , set the
JAVA HOMEenvironment variable to the installation directory of your Java
Virtual Machine (JVM).

3. Type:
prompt% /opt/SUNWconn/bin/deja [ hostname [. port_number ]]
where:

¢ hostnamas the hostname of the directory server. The default is localhost.
e port_numbeis the port number of the directory server. The default is 389.

Note The machine on which you are running Deja needs to have a Java Virtual Machine
and JDK version 1.1.5 or a compatible version installed.

Logging In

Directory access rights are defined by a set of access control rules on the directory
server. You must be the directory administrator to modify the access control rules.
When you log in to the directory, your username and password are compared with
those stored in the directory. If there is a match, the access rights defined in the access
control rules are granted.

You can browse the directory content without logging in, but you must have write
permission before you can modify directory entries. Figure 3.2 shows the Login
panel.

Note It may not be possible to browse the directory content without logging in. This
depends on the access control rules defined in the directory server.
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Figure 3.2 Deja Login Panel

To log in to Deja:

1.

2. Type the Distinguished Name (DN) of your entry in the User text field:
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Click on the Login icon or select Login from the File menu.

If you need to log in often, you can create a login alias in the

Deja.properties file. See “Setting Deja Properties” on page 76 for

information on creating a login alias.

If you cannot remember your full DN, you can search for it in the directory:

1.

2.
The DN is transferred to the User text field.

Type your password in the Password field.

Select the desired profile (Standard, NIS or RADIUS) from the Profile option

Type your user name or a substring of your name in the User text field and
click the Search button in the login panel. The search can include the wildcard

character *.

Double-click on your name in the Matching Usernames window.

button.

The default profile is Standard.

Click Login.




General Operations

Your password is compared to the password stored in the directory. If there is no
match the login fails.

General Operations

This section gives some tips on how to use Deja.

Setting the Display Options
The Options menu is used to hide or show the toolbar, status bar, or directory browser.

The default view has all of these elements.

To hide or show an element, select it from the Options menu to change its status.

Setting Deja Properties

The Deja Properties panel displays information about the selected user profile, and the
connection to the directory server. To access the Properties panel, select Properties
from the File menu.

The Properties panel is displayed, and shows the user properties and connection
properties of Deja. See Figure 3.3.
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Figure 3.3 Deja Properties Panel

User Properties

The User Properties pane displays the name of the connected user and the user profile
for creating or modifying entries.

Name

If you are not logged into the directory sern@npnymousis displayed. If you have
logged in, the login name is displayed.

User Profile

To set the user profile, select the profile (Standard, NIS or RADIUS) from the Profile
option button in the User Properties pane.

The default profile is Standard.

Connection Properties

The Connection Properties pane displays the name of the directory server to which
Deja is connected, and the connection port number.
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Server and Port Number

Deja displays information about its connection to the directory server. The default
port number that Deja uses to connect to the directory server is 389. The host name
and port number can be specified when Deja is started.

When you start Deja, you can specify the host name and port number on the command
line. See “Starting Deja” on page 48.

To connect to a different directory server or change the port number from within Deja
see “Connecting to Another Directory Server” on page 54.

Opening a New Deja Window

To open a new window in Deja, from the File menu select New Window. The new
window has its own connection to the directory server.

Closing a Deja Window

To close a Deja window, select Close from the File menu. The Deja window is closed.

To close all Deja windows, select Exit from the File menu. A confirmation window is
displayed. Click Yes to close all Deja windows.

Reconnecting Deja to the Directory Server

If the directory server is disabled for some reason, Deja loses its connection to the
directory. Deja does not automatically reconnect to the directory server when it is
re-enabled.

To reconnect Deja to the directory server, select Connect from the File menu. Deja is
reconnected.
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Connecting to Another Directory Server

1. To connect Deja to a different directory server, select Connect To... from the File
menu.

The Connect To... dialogue box is displayed.

2. Dejatries to connect to the new directory server. If it is unable to connect, an error
message is displayed.

Refreshing the Browser Window

If directory operations are being performed on the same directory server by another
user or by the administrator, the browser window is not automatically updated. To
refresh the browser window:

1. In the browser window, click on the root entry of the branch you want to refresh.

You can choose to refresh all of the directory by selecting the directory root entry,
or to refresh just a branch by clicking on the root entry of the branch.

2. From the File menu, select Refresh Subtree.

All the branches of the directory below the selected entry are collapsed in the
browser window. When they are reopened, they are refreshed.

Operations on RADIUS Entries

This section describes the read, create, modify, delete and search operations that can
be performed on directory entries using Deja. Deja offers specific templates for
creating, modifying and searching for RADIUS entries.

To view the RADIUS-specific panels you must change the Deja user profile to
RADIUS, as explained in “User Properties” on page 52.
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Viewing an Entry

Use View to look at the attributes defined for an entry in the directory. Figure 3.4
shows the Deja View window with an example entry. You can only open one View
window per entry. To refresh a View window after modifying an entry, view the entry
again. The original View window is replaced with a new one.

|~ oeaview |||

window Edit |
cn=Felipe Gonzalez,ou=People,0=5un.COM
Attribute Walue
= lradiusppppasswid fcrypted:
= lobjectclass remotelser
= |uid fgonzalez
= [radiuspppprofile 1
= icn Felipe Gonzalez
% |[grpcheckinfo radiuspppprofile
radiusPppPasswid

Figure 3.4 Deja View Window

When an attribute has more than one value, an arrow is displayed next to the attribute
name in the entry definition: a right arrow when the values are collapsed, and a down
arrow when the values are expanded.

The View Window

There are three ways to display the View window:

» Double-click on an entry in the browser window

» Select an entry in the browser window and click on the View icon, or from the
Entry menu, select View

» Double click on an entry in the search results list

Closing a View Window

To close a View window, select Close from the Window menu of the View window.
Alternatively, you can double click on the Window menu button.
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Copying an Entry From a View Window

To copy an entry from a View window, select Copy from the Edit menu of the View
Window. The entry is copied to the clipboard.

Highlighting an Entry From a View Window

To highlight an entry in Deja’s browser window from the View Window, select
Highlight from the Edit menu.

Creating a New Entry

The Deja create panel can be used to add new entries to the directory.

Figure 3.5 shows the Deja Create panel for RADIUS users.
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Figure 3.5 Deja Create Panel for RADIUS Users

1. Loginto Deja as a user that has write permissions to the directory.

2. Click on the Create icon or select Create from the Entry menu.
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Operations on RADIUS Entries

The Create panel is displayed.

There are two steps to creating a RADIUS directory entry. You must complete
each step before you can progress to the next one. Click on Next Step and
Previous Step to navigate between the steps.

¢ Name the entry. See “Naming an Entry” on page 57.

« Assign attributes to the entry and name them. See “Selecting Attributes” on
page 58.

When you have completed the entry definition, click Done.

Naming an Entry

To assign a name to an entry:

1.

2.

Select the type of entry you want to add (Remote User or Remote Access Server).
If you are adding a Remote User, specify the profile of the new entry (Standard,
PPP, SLIP, LOGIN).

The list of RADIUS profiles available in Deja is defined in the
Deja.properties file on the directory server. See “RADIUS Profiles” on
page 84 for information on defining RADIUS user profiles.

Specify the parent of the entry.

By default, the Parent text field holds the distinguished name of an entry specified
in theDeja.properties file on the directory server. To select another parent
entry:

« Type the Distinguished Name of the Entry’s parent in the Parent text field.

« Alternatively, click once on the parent in the browser window to select it and
click the Get From Browser button next to the Parent text field. The
Distinguished Name of the selected entry is imported to the Parent text field.

Name the entry by selecting a naming attribute with the option button next to the
Entry’s name field.

The list of available naming attributes is defined in Breja.properties file
on the directory server.

Type the value for the naming attribute of the entry in the Entry Name text field.
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6. When you are satisfied with the entry name and parent, click the Next Step button
to assign values to the attributes.

7. The list of attributes available for selection is different depending on the type of
entry you selected in Step 1 and Step 2.

See “Selecting Attributes” on page 58 for information on selecting attributes for
the entry. The attributes available for selection are defined for each object class in
the schema.

Selecting Attributes

Each object class has a number of mandatory and optional attributes associated with
it. An entry definition table, with the current list of attributes and values is displayed
in the right pane. Mandatory attributes are marked with (M), optional attributes with
(0).

The names of the mandatory attributes are already listed in the entry definition before
you assign a value to them. To complete the entrynyastprovide values for these
attributes. If you try to add an entry to the directory without assigning values to all the
mandatory attributes, an error message is displayed.

Some attributes accept multiple values, others can only have one value. By default,
attributes are multi-valued. Single-valued attributes are identified in the schema by
the SINGLE-VALUE keyword. If you try to add more than one value to a
single-valued attribute, an error message is displayed.

Assigning a Value to an Attribute
To assign a value to an attribute:

1. From the Choose Attribute list, or from the entry definition, select the attribute for
which you want to add a value.

2. Type the value for the attribute in the text field.

3. Click Add to add the value of the attribute to the entry definition.

The value appears in the entry definition next to the attribute. For information on
the Chk Add, Rpl Add, Chk Delete and Rpl Delete buttons, see “Check Data and
Reply Data Attributes” on page 59.

4. To add another value for an attribute, repeat steps 1 to 3.
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6.

Operations on RADIUS Entries

Click on Done to add the entry to the directory.

Double click on the entry in the browser to display all of its attributes.

Deleting a Value From an Attribute

To delete an attribute value:

1.

2.

Select the value or the attribute name in the entry definition.
Click Delete.

If you delete the only value for an optional attribute, the attribute is removed from
the entry definition.

If you delete the only value for a mandatory attribute, the value is cleared from the
entry definition. The attribute stays in the definition.

Modifying an Attribute Value

To modify an attribute value:

1. Select the value of the attribute you want to modify in the entry definition.
The attribute value appears in the text field.

2. Change the value and click Modify.
The modified value appears in the entry definition.

Cancel

To cancel a create operation at any time, click Cancel in the Create panel. The entry
definition is cleared.

Check Data and Reply Data Attributes

The RADIUS attribute selection window features four special buttons:

Chk Add

Select an attribute and type a value for it in the text window. If you click the Chk
Add button, the value is added to the entry definition, and the name of the attribute
is added to the Radius Check Data optional attribute which matches the
grpCheckinfo attribute in the directory schema for RADIUS.
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For example, if you select the User ID attribute from the Choose Attribute list and
type the valueharlesin the text window, when you click on Chk Add, the value
charlesis added to the User ID attribute, and the uid attribute is added to the
Radius Check Data attribute.

. Rpl Add

Select an attribute and type a value for it in the text window. If you click the Rpl
Add button, the value is added to the entry definition, and the name of the attribute
is added to the Radius Reply Data optional attribute which matches the
grpReplylnfo attribute in the directory schema for RADIUS.

* Chk Del

Select the value of the attribute you want to delete from the entry definition. If you
click the Chk Del button, the value is removed from the entry definition, and the
name of the attribute is removed from the Radius Check Data optional attribute
which matches the grpCheckinfo in tlalius.mapping file.

* Rpl Del

Select the value of the attribute you want to delete from the entry definition. If you
click the Rpl Del button, the value is removed from the entry definition, and the
name of the attribute is removed from the Radius Reply Data optional attribute
which matches the grpReplyinfo attribute in the directory schema for RADIUS.

The grpCheckinfo attribute contains a list of attributes that must be checked by the
RADIUS server against the information supplied by the remote user. If the
grpCheckinfo attribute is not present, then access is denied.

The grpReplylInfo attribute contains a list of attributes returned by the RADIUS server
with an access-accept or access-reject response. It can contain connection parameters
such as a PPP or SLIP profile. If the grpReplyInfo attribute is not present, the remote
user can connect from any host or IP address, and through any connection protocol.

Deleting an Entry

The delete panel of Deja is used to delete entries from the directory. Figure 3.6 shows
the Deja Delete panel.
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Figure 3.6 Deja Delete Panel

You must have write permission for the entry you want to delete. See “Logging In” on
page 49 for information.

1. Select the entry you want to delete in the browser window.

You can only delete leaf entries. You cannot delete a root entry or a parent that
still has children.

2. Click on the Delete icon, or select Delete from the Entry menu.
The Delete panel is displayed.

3. Click on Delete to remove the entry from the directory.
4. Click on Cancel to clear the delete panel.

There is no undelete function.

Cut, Copy and Paste

This section explains how to perform cut, copy and paste operations on directory
entries using Deja.
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Cutting an Entry

Use Cut to remove an entry from the directory and keep a copy of it on the clipboard.
The entry can be pasted from the clipboard into the directory in another location.

You must have write permission for the entry you want to cut. See “Logging In” on
page 49 for information.

To cut an entry from the directory:
1. Inthe browser, click on the entry you want to cut.

2. Click on the Cuticon. Alternatively, select Cut from the Edit menu, or press Ctrl-x
on the keyboard.

The entry is cut from the directory to the clipboard. You can now paste the entry
to a new location in the directory.

3. If you want to restore the entry to the directory, select Restore from the Edit menu.

The entry is restored to its original position in the directory, if possible. If the parent
entry no longer exists, or has been renamed, the paste is not possible and an error
message is displayed.

Copying an Entry

Use Copy to copy an existing entry from the directory into the clipboard. The entry
can then be pasted from the clipboard into the directory in another location.

To copy an entry in the directory:
1. Inthe browser, click on the entry you want to copy to select it.

2. Click on the Copy icon. Alternatively, select Copy from the Edit menu, or press
Ctrl-c on the keyboard.

The entry is copied from the directory to the clipboard.

You can now paste the entry to a new location in the directory.
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Pasting an Entry

After a Cut or Copy operation, use Paste to paste an entry from the clipboard into the
directory. You can paste at different levels in the directory tree:

e Atthe same level as the entry you copied or cut into the clipboard
* Atany level in the directory tree

You must have write permission to paste an entry into the directory. See “Logging In”
on page 49 for information.

1. To copy an entry and paste it at the same level in the subtree:

Immediately following the copy operation, click on the Paste icon. Alternatively,
select Paste from the Edit menu, or press Ctrl-v on the keyboard.

In the browser window, the pasted entry is displayed. A sequence number is
appended to its name to ensure naming remains unique at a given level in the
directory tree.

2. To cut or copy an entry and paste it at a different level:

Select the new parent entry for the entry you want to paste, and click on the Paste
icon. Alternatively, select Paste from the Edit menu, or press Ctrl-v on the
keyboard.

To copy an entry, and paste it immediately below the copied entry, you must click
elsewhere in the directory tree to deselect the copied entry, then click on it again
to select it, then perform the paste. If you do not deselect then reselect, the entry in
the clipboard is pasted at the same level, not one level below.

Restoring an Entry

If you accidentally cut an entry from the directory, you can restore it, provided that
you have not performed any subsequent cut or copy operations.

To restore an entry that you have just cut from the directory, select Restore from the
Edit menu. The entry on the clipboard is returned to its original location.
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Modifying an Entry

Use Modify to change attributes and object classes in RADIUS directory entries. The
Deja Modify panel is very similar to the attribute selection panel that you use to create
an entry. See Figure 3.5.

You must have write permission for the entry you want to modify. See “Logging In”
on page 49 for information.

1. Inthe browser, click on the entry you want to modify.

2. Click on the Modify icon or select Modify from the Entry menu.
The Modify Attributes window is displayed.

< To modify attributes of the entry, see “Selecting Attributes” on page 58.

« To change the name of the entry, use the Rename function. See “Renaming an
Entry” on page 64.

The RADIUS modify attributes window features four special buttons: Chk Add,
Rpl Add, Chk Del, and Rpl Del. See “Name” on page 52 for detalils.

3. When you have finished the modifications, click Done.

Reset

To cancel a modify operation at any time, click Reset. The entry definition is cleared
from the Modify panel.

Renaming an Entry

Use Rename to modify the Relative Distinguished Name (RDN) of an entry. Figure
3.7 shows the Deja Rename panel.
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Figure 3.7 Deja Rename Panel

You must have write permission for the entry you want to rename. See “Logging In”
on page 49 for information.
1. Select the entry you want to rename in the browser window.
You can only rename leaf entries. You cannot rename parents that still have
children, or the root entry.
2. Click on the Rename icon, or select Rename from the Entry menu.
The rename panel appears. The name of the parent and the Relative Distinguished
Name (RDN) of the selected entry are displayed.
3. Type the new RDN of the entry in the To text field.

If you want the new RDN to replace the old RDN, check the Remove old RDN
check box.

By default the new RDN replaces the old RDN. If the Remove old RDN check
box is unchecked, the new RDN is added to the entry as an additional value.

4. Click the Rename button.
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Searching for an Entry

Use Search when you want to find a RADIUS entry in the directory. This function
provides search facilities for up to three criteria. Figure 3.8 shows the Deja Search
panel for RADIUS users.
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Figure 3.8 Deja Search Panel for RADIUS Users

To search for a RADIUS entry, click on the Search icon, or select Search from the
Entry menu. The Search panel is displayed.

Note The types of searches available, and the categories of search results are defined in the
Deja.properties file on the directory server. See “RADIUS Search Panel
Definitions” on page 81 for information on defining searches.

The default search types are:
* Remote User search; see “Remote User Searches” on page 67

» Remote Access Server (RAS) search; see “Remote Access Server Search” on
page 72

» Complex Searches; see “Complex Searches” on page 73

You can combine Remote User searches with Remote Access Server searches using
AND or OR operators. You cannot combine both operators in the same search. Up to
three search criteria can be defined.
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Remote User Searches
There are seven searches pre-defined for remote user entries:

e Search by login name
Where Deja searches for entries that have the remoteuser objectclass and whose
user id matches the text field. See “Login Name Search” on page 68.

» Search by user name
Where Deja searches for entries that have the remoteuser objectclass and whose
user name matches the text field. See “User Name Search” on page 68.

» List blocked accounts
Where Deja searches for entries that have the remoteuser object class and that
have one or more failed authorization accesses. See “Blocked Accounts Search”
on page 69.

» List PPP users
Where Deja searches for entries that have the remoteuser object class, a PPP
profile, and a PPP password set. See “List PPP Users Search” on page 69.

o List SLIP users
Where Deja searches for entries that have the remoteuser object class, a SLIP
profile, and a SLIP password set. See “List SLIP Users Search” on page 70.

» List LOGIN users
Where Deja searches for entries that have the remoteuser object class, a LOGIN
profile, and a LOGIN password set. See “List LOGIN Users Search” on page 71.

e Search by name and mail

Where Deja searches for entries that have the remoteuser object class and whose
name and email address match the text fields. See “User Name and Mail Search”
on page 71.

To define a new type of search, see “RADIUS Search Panel Definitions” on page 81.

The search root for remote user searches is storediadius.mapping  file, in
theBaseDN variable. It is also stored in tieja.properties file.
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Login Name Search

To perform a login name search:

1.

2.

Select Remote User from the Type of Search option button.
Select Search by Login Name from the Defined Searches option button.

Type the User ID of the entry you want to find in the search text field.
The search can include the wildcard character *.

Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
other remote user object class searches. See “Complex Searches” on page 73.

To stop the search at any time, click the Stop button.
The search is stopped and no results are returned.

Click the Clear button to clear the search text field.

User Name Search

To perform a user name search:

1.

2.
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Select Remote User from the Type of Search option button.
Select Search by User Name from the Defined Searches option button.

Type the user name of the entry you want to find in the search text field.

The search can include the wildcard character *.

Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
other remote user object class searches. See “Complex Searches” on page 73.
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5. To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

6. Click the Clear button to clear the search text field.

Blocked Accounts Search
To perform a blocked accounts search:
1. Select Remote User from the Type of Search option button.

2. Select List Blocked Accounts from the Defined Searches option button.

There are no user input fields for this search. Deja searches for entries with the
following parameters:

objectclass = remoteuser
radiusAuthFailedAccess > RADIUS_MAX_FAIL

WhereRADIUS_MAX_FAILis defined in th®eja.properties file on the
directory server. The default value RADIUS_MAX_FAILis 4. See “RADIUS
Properties” on page 119 for information.

3. Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
other remote user object class searches. See “Complex Searches” on page 73.

4. To stop the search at any time, click the Stop button.
The search is stopped and no results are returned.

5. Click the Clear button to clear the search text field.

List PPP Users Search
To perform a PPP users search:
1. Select Remote User from the Type of Search option button.

2. Select List PPP Users from the Defined Searches option button.
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There are no user input fields for this search. Deja searches for entries with the
following parameters:

objectclass = remoteuser

radiusPppProfile = *

radiusPppPasswd = *

3.

Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
other remote user object class searches. See “Complex Searches” on page 73.

To stop the search at any time, click the Stop button.
The search is stopped and no results are returned.

Click the Clear button to clear the search text field.

List SLIP Users Search

To perform a SLIP users search:

1.

2.

Select Remote User from the Type of Search option button.

Select List SLIP Users from the Defined Searches option button.

There are no user input fields for this search. Deja searches for entries with the
following parameters:

objectclass = remoteuser

radiusSlipProfile = *

radiusSlipPasswd = *

3.
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Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
other remote user object class searches. See “Complex Searches” on page 73.



4.

5.

Operations on RADIUS Entries

To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

Click the Clear button to clear the search text field.

List LOGIN Users Search

To perform a LOGIN users search:

1.

2.

Select Remote User from the Type of Search option button.

Select List LOGIN Users from the Defined Searches option button.

There are no user input fields for this search. Deja searches for entries with the
following parameters:

objectclass = remoteuser

radiusLoginProfile = *

radiusLoginPasswd = *

3.

Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
other remote user object class searches. See “Complex Searches” on page 73.

To stop the search at any time, click the Stop button.
The search is stopped and no results are returned.

Click the Clear button to clear the search text field.

User Name and Mail Search

To perform a user name and mail search:

1.

2.

Select Remote User from the Type of Search option button.
Select Search by Name / Mail from the Defined Searches option button.

Type the username and email address of the entry you want to find in the search
text fields.
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6.

The search can include the wildcard character *.

Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with RAS object class searches or
other remote user object class searches. See “Complex Searches” on page 73.

To stop the search at any time, click the Stop button.
The search is stopped and no results are returned.

Click the Clear button to clear the search text field.

Remote Access Server Search

There are two searches pre-defined for RAS (NAS) entries:

Search by RAS Name

Where Deja searches for all entries that have the objectclass RAS and whose RAS
name matches the text field. See “RAS Name Search” on page 72.

Search by RAS IP Address

Where Deja searches for all entries that have the objectclass RAS and whose RAS
network address matches the text field. See “RAS IP Address Search” on page 73.

To define a new type of search, see “RADIUS Search Panel Definitions” on page 81.

The default search root for RAS searches is stored ingtiis.mapping  file, in
theBaseDN variable. It is also stored in tiBeja.properties file.

RAS Name Search

To perform a RAS name search:

1.

2.
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Select Remote Access Server from the Type of Search option button.
Select Search by RAS Name from the Defined Searches option button.

Type the name you want to find in the search text field.
The search can include the wildcard character *.



4.

6.
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Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with remote user object class searches
or other RAS searches. See “Complex Searches” on page 73.

To stop the search at any time, click the Stop button.

The search is stopped and no results are returned.

Click the Clear button to clear the search text field.

RAS IP Address Search

To perform a RAS IP address search:

1.

2.

Select Remote Access Server from the Type of Search option button.
Select Search by RAS IP Address from the Defined Searches option button.
Type the IP address you want to find in the search text field.

Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

You can refine your search by combining it with remote user object class searches
or other RAS searches. See “Complex Searches” on page 73.

To stop the search at any time, click the Stop button.
The search is stopped and no results are returned.

Click the Clear button to clear the search text field.

Complex Searches

You can combine three types of search with the complex searches option:

Remote User searches
Remote Access Server searches

Chapter 3, Using Deja to Update RADIUS Informatiatd



Operations on RADIUS Entries

Specify Filter; see “Search Filters” on page 74 for a description of acceptable
filters

Searches can be combined with AND or OR operators. You cannot combine both
operators in the same search. Up to three search criteria can be defined.

To perform a complex search:

1.

2.

Select Complex Searches from the Type of Search option button.

Select the first search criterion from the Remote User option button and type the
search string or filter definition in the text field.

Click on the And or Or buttons to select the logical operator.

Select the second search criterion from the Remote User option button and type
the search string or filter definition in the text field.

If you want to add a third search criterion, click the And or Or button again.
To remove a search criterion, click the Back button.

Type the Distinguished Name (DN) of the root of the tree you want to search, or
select the root you want to search in the browser window and click Get from
Browser.

Click Search to start the search.

The search results are displayed in the search results list and the number of entries
found is displayed in the status bar. If there are no matches, the search results list
is empty and the status bar indicates that no entries were found.

To stop the search at any time, click the Stop button.
The search is stopped and no results are returned.

10. Click the Clear button to clear the search text field.

Search Filters

Using a search filter is a way of specifying a set of entries, based on the presence of a
particular attribute or attribute value. You can combine AND or OR logical operators
in the same search. Use & (ampersand) for AND and | (the pipe symbol) for OR.
Table 3.2 gives some examples of filters.
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Table 3.2 Search Filter Examples

Filter

I=London

cn=*Rob*
(&(cn=Ch*)(cn=*Thomas*))

(I(sn=*bert*)(sn=*bort*))

Operations on RADIUS Entries

Definition
locality is "London"
common name contains "Rob"

common name starts with "Ch" and contains
"Thomas"

surname contains "bert" or "bort"

(&(cn=Rob*)(](cn=*Green*)(cn=*Jones*)) common name starts with "Rob" and contains

Search Results List

"Green" or "Jones"

Search results are displayed in a list below the search criteria.

The headings of the search results table depend on the search. The types of searches,
and the headings for search results are defined iD#ja.properties
directory server. All the headings can be modified except those for complex searches.

file on the

See “RADIUS Search Panel Definitions” on page 81 for information on defining

searches.

Table 3.3 shows the attributes returned for the default searches.

Table 3.3 RADIUS Search Results Lists

Search Type
remoteUser login name
remoteUser user name

Attributes
cn, uid, framedProtocol

cn, uid

remoteUser blocked accounts
remoteUser List PPP users
remoteUser List SLIP users
remoteUser List LOGIN users
remoteUser name/mail address
RAS name

RAS IP address

Complex searches

cn, uid, radiusFailedAccess
cn, uid
cn, uid
cn, uid
cn, uid
cn, ipHostNumber
cn, ipHostNumber
cn, ipHostNumber, uid, radiusFailedAccess
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To view an entry from the search results list, double-click on the entry’s name. The
view entry window is displayed, and the entry is highlighted in the browser window.

Setting Deja Properties

This section describes how to configure Deja properties, and the maintenance
operations required to synchronize Deja properties with configuration changes that
occur on the directory server side.

Many of Deja’s characteristics can be configured by the directory administrator. The
characteristics are defined in theja.properties file on the directory server.

File Structure

The Deja.properties file is located in théopt/SUNWconn/ldap/html
directory on the directory server. You must be authenticatsdipsruser orroot
to modify theDeja.properties file.

TheDeja.properties file consists of four sections:
» “General Properties” on page 77

e “Standard LDAP Properties” on page 79

* NIS Properties

* “RADIUS Properties” on page 80

Some of the properties described in Erega.properties file are not relevant to
the topics discussed in this book. In particular, this section does not explain the
meaning of the NIS parameters.

File Syntax

Each section in thBeja.properties file contains a list of definitions. Each
definitition ends with a carriage return. The different elements in a definition are
separated by commas. Related elements are separated by semi-colons.

For example, the attributes returned in RADIUS searches are defined as follows:
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RADIUS_RU_LIST.default=" cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL

In this example, the definition is composed of two elements, separated by a comma.
Each element consists of an attribute type (cn and uid in this example), and a label that
is displayed in Deja, in the results table header row.

This example does not show the actual labels that appear in Deja’s menus. These are
defined separately, in thecalized resource bundl@he localized resource bundle
contains translations in every supported locale for the user interface of Deja.

Labels

Standard Deja labels and identifiers (parameters endingABEL, _IDENTIFIER
or _CHOICB are defined in the localized resource bundle. You cannot change these
definitions. You can, however, create your own labels.

For example, if you want to add the ipHostNumber attribute type to the list returned
by default in a search on RADIUS remote users, you might modify the
RADIUS _RU_LIST.default  definition as follows:

RADIUS_RU_LIST.default=" cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL, ipHostNumber;Host Number

This definition is local to youDeja.properties file. It is not part of the
localized resource bundle.

General Properties

In the General Properties section the following parameters are defined:
SCHEMA_THREAD_TIME_LIMIT

Defines a time limit in milliseconds on the time it takes Deja to read the schema.
The default value is no time limit.

REFERRALS_MANAGE_DSA

With this option set terue, entries with the referral object class are treated like
normal entries, that is the entry itself is returned in the search results. With this
option set tdalse, Deja returns a search reference result. The default value is
true.
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BROWSER_ENTRY_LIMIT

Specifies the maximum number of entries that can be displayed in the browser. If
a limit has been set, you must refresh certain subtrees before opening more. The
default value is no limit.

BROWSER_SUBENTRY_LIMIT

Defines the maximum number of immediate children of an entry that can be
displayed in the browser. The default value is no limit.

BROWSER_LOAD_SUBNODES_TIME_LIMIT

Specifies the maximum amount of time allowed for Deja to load the children of a
node when the node is opened in the browser. This is not the amount of time it
then takes to display those children. The default valt6,@00milliseconds.

BROWSER_CHECK_NODE_TIME_LIMIT

This is the maximum time taken for Deja to verify whether an entry is a leaf or a
node. The default value 2000milliseconds.

STANDARD_SECURITY_AUTHENTICATION

Defines the standard authentication mechanism used in the login panel. The only
possible value for this parametesimple.

The following example shows the General Properties section of the
Deja.properties file.

# schema thread time limit in milliseconds (0 = no limit)
SCHEMA_THREAD_TIME_LIMIT=0

#

# manage referrals as entries (true or false)
REFERRALS_MANAGE_DSA=true

#

# max. number of nodes in browser tree (0 = no limit)
BROWSER_ENTRY_LIMIT=0

# max number of subnodes of a node in the browser tree (0 = no limit)
BROWSER_SUBENTRY_LIMIT=0

# time limit to load subnodes (in ms, 0 = no limit)
BROWSER_LOAD_SUBNODES_TIME_LIMIT=10000

# time limit to verify if entry is a leaf or an inner node (in ms, 0 =
no limit)

BROWSER_CHECK_NODE_TIME_LIMIT=2000
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#

# authentication mechanism

# supported values : CRAM-MDS5, simple (cleartext password)
# STANDARD_SECURITY_AUTHENTICATION=CRAM-MD5
STANDARD_SECURITY_AUTHENTICATION=simple

Standard LDAP Properties

In the Standard LDAP Properties section ofDrega.properties file you can:
» Specify which attribute values are hidden in Deja
» Specify parameters for the login panel

» Define new standard search filters

Hiding Attributes

STANDARD_ATTRIBUTES_CRYPTED

In the View, Modify and Create windows of Deja, some attribute values are not
displayed, or replaced by a localized text string. You can specify the attributes
you want to be hidden by adding them to the
STANDARD_ATTRIBUTES_CRYPTHBY. Attribute names are separated by
commas. By default the values for userpassword, radiusppppasswd,
radiusloginpasswd, chappassword, and radiusslippasswd are hidden.

Login Parameters

STANDARD_LOGIN_SEARCH_FILTER

The search feature of the login panel operates using the filter defined with this
label. By default it ig](cn=*{0}*)(uid=*{0}*)) . This search filter

means that either the cn attribute or the uid attribute should contain the search
string typed by the user in the search text field.

STANDARD_LOGIN_MAX_SEARCH_RESULT

Specifies the maximum number of search results per naming context returned by a
login search. The default value is 55.
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Note

STANDARD_LOGIN_ALIASES

Defines an alias for the user DN you use to login to Deja. By default, there are no
aliases defined, and tIB@ANDARD_LOGIN_ALIASE$arameter is commented
out. The definition in th®eja.properties file reads as follows:

# STANDARD_LOGIN_ALIASES= userA_alias; userA_dn; userB_alias; userB_dn

To add a login alias, you must uncomment the line, add an alias name and a user
DN for login. For example, if the user cn=Robert Travis, ou=sales,o=sun,c=us
wants to login frequently, you can create an alias for him, for example, rob. To add
this alias, you would edit tfeTANDARD_LOGIN_ALIASESlefinition in the
Deja.properties file to read as follows:

STANDARD_LOGIN_ALIASES= rob; cn=Robert Travis, ou=sales,o=sun,c=us

If you create several aliases, you must use a semi-colon to separate them, and not a
comma, which is the standard syntax, because the comma is used to separate the
different elements in the DN. The semi-colon separates the elements of a DN from a
new alias definition.

For example, if you also wanted to add an alias for an administrator user whose
DN is cn=Directory Manager, o=sun, c=us, 8IBANDARD_LOGIN_ALIASES
definition in theDeja.properties file would read as follows:

STANDARD_LOGIN_ALIASES= rob ; cn=Robert Travis, ou=sales,o=sun,c=us ;
Directory Manager ; cn=Directory Manager, o=sun, c=us

When Deja is restarted the aliases are available in the Login panel. This parameter
is case-sensitive.

RADIUS Properties

You can use the RADIUS properties section oflbiega.properties file to
define new templates for:

* Performing RADIUS searches
» Creating RADIUS entries
» Defining RADIUS profiles
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RADIUS Search Panel Definitions

To add a RADIUS search to Deja, define it in the Radius Search Panel section of the
Deja.properties file. Remote User searches are declared in the
RADIUS_RU_SEARCHefinition, and Remote Access Server searches are defined in
theRADIUS_RAS_SEARCHEfinition. Each search is then defined on a separate

line.

A search definition consists of:
» The search name (for exampdeuser )

e The label that appears in the Search Type option button (for example,
RADIUS_RU_SEARCH_USER_LABEL

» The search definition
For example:

(& (objectclass=remoteuser)(uid={$uid;RADIUS_RU_UID_ATTR_LABELS$}))

RADIUS_COMPLEX_SEARCH_LIST

Contains a list of the attributes and header labels for the complex search results
table. By default the cn, iphostnumber and uid attributes are listed.

Adding a RADIUS Remote Access Server Search
To add a RADIUS Remote Access Server search for the mail attribute:

1. Declare the search definition in tRADIUS RAS SEARCHhe:

RADIUS_RAS_SEARCH=s_name;RADIUS_RAS_SEARCH_NAME_LABEL,
s_addr,RADIUS_RAS_SEARCH_IPADDR_LABEL, s_mail;Search by Email
The name for the new searchdsmail , and the label that appears in the Search
Type option button is Search by Email.

2. Define the search:

RADIUS_RAS_FILTER.s_mail=(& (objectclass=nas)
(uid={$uid;Email;string$}))

The expressioffsuid;Email;string$} tells Deja that for this search, the
user input is a text stringtfing ), the label to appear by the text field is Email
(Email ), and that the search text string is a useuid §.
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3. Define the headings for the search results table:

RADIUS_RAS_LIST.s_mail= cn;RADIUS_RAS_CN_ATTR_LABEL, uid;Email

If you do not specify RADIUS_RAS_LIST for the search, the default headings
are usedRADIUS_RAS_LIST.default ).

4. Close Deja and restart it.

Your search type is added to the RADIUS Remote Access Server Search panel.

The following code example is an extract of Beja.properties file showing
the RADIUS search definitions:

# Radius SEARCH PANEL

# Searches defined for Remote Users

RADIUS_RU_SEARCH=s_user;RADIUS_RU_SEARCH_USER_LABEL,
s_name;RADIUS_RU_SEARCH_NAME_LABEL,
|_bl_acc;RADIUS_RU_LIST _BLOCKED_ACCOUNTS_LABEL ,
|_ppp;RADIUS_RU_LIST_PPP_USER_LABEL,
|_slip;RADIUS_RU_LIST_SLIP_USER_LABEL,
|_login;RADIUS_RU_LIST LOGIN_USER_LABEL,
s_n_u;RADIUS_RU_SEARCH_NAME_UID_LABEL

# Associated filters for Remote User searches

RADIUS_RU_FILTER.s_user= (&
(objectclass=remoteuser)(uid={$uid;RADIUS_RU_UID_ATTR_LABELS$}))

RADIUS_RU_FILTER.s_name= (&
(objectclass=remoteuser)(cn={$cn;RADIUS_RU_CN_ATTR_LABELS$}))

RADIUS_RU_FILTER.|_bl_acc= (&
(objectclass=remoteuser)(radiusAuthFailedAccess>=$RADIUS_MAX_FAIL))

RADIUS_RU_FILTER. ppp= (&
(objectclass=remoteuser)(radiusPppProfile=*)(radiusPppPasswd=*))

RADIUS_RU_FILTER.I_slip= (&
(objectclass=remoteuser)(radiusSlipProfile=*)(radiusSlipPasswd=*))

RADIUS_RU_FILTER. login= (&
(objectclass=remoteuser)(radiusLoginProfile=*)(radiusLoginPasswd=*))

RADIUS_RU_FILTER.s_n_u= (&
(objectclass=remoteuser)(cn={$cn;RADIUS_RU_CN_ATTR_LABELS$})(uid={$uid;R
ADIUS_RU_UID_ATTR_LABEL$}))
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# Attributes to be included (listed) in the search results

RADIUS_RU_LIST.s_user= cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL,
framedProtocol;RADIUS_RU_FRAMEDPROTOCOL_ATTR_LABEL

RADIUS_RU_LIST.| bl_acc= cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL,
radiusAuthFailedAccess;RADIUS_RU_RADIUSAUTHFAILEDACCESS_ATTR_LABEL

RADIUS_RU_LIST.default=" cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL

# Searches defined for RAS (Remote Access Servers)

RADIUS_RAS_SEARCH=s_name;RADIUS_RAS_SEARCH_NAME_LABEL,
s_addr;RADIUS_RAS_SEARCH_IPADDR_LABEL

# Associated filters for NAS searches

RADIUS_RAS_FILTER.s_name= (&
(objectclass=NAS)(cn={$cn;RADIUS_RAS_CN_ATTR_LABELS$}))

RADIUS_RAS_FILTER.s_addr= (&
(objectclass=NAS)(iphostnumber={$iphostnumber;RADIUS_RAS_IPHOSTNUMBER_A
TTR_LABEL;ipaddr$}))

# Attributes to be included (listed) in the search results

RADIUS_RAS_LIST.default= cn;RADIUS_RAS_CN_ATTR_LABEL,
iphostnumber;RADIUS_RAS_IPHOSTNUMBER_ATTR_LABEL

# Attributes to be listed in case of a complex search

RADIUS_COMPLEX_SEARCH_LIST=cn;RADIUS_CN_ATTR_LABEL,
iphostnumber;RADIUS_RAS_IPHOSTNUMBER_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL

RADIUS Create Panel Definitions

You can define alternate names for attributes that are displayed in the Choose
Attributes list of the RADIUS Create panel. You can also restrict user input to one of
the four basic input type#n€, string, crypt andipaddr). The defaulinput_typeis

string.
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RADIUS_RU_ADD_COMM®@#éfines attributes for Remote User Entries that are
common to all remote user profiles, dRADIUS_RAS_ADD_COMM®@&fines
attributes for Remote Access Server entries that are common to all remote user
profiles. The syntax of an attribute definition is:

RADIUS_RAS_ADD_COMMON¢#tribute_name  ; label ; input_type

Where:
attribute_namas the name of an attribute

labelis the name you want to appear in the Choose Attributes list instead of the
attribute name

input_types one of the four basic input typeisi{, string, crypt andipaddr). The
default input_type istring.

The following code example is an extract of Beja.properties file
showing the RADIUS create panel definitions:

# Radius ADD PANEL

RADIUS_RU_ADD_COMMON=  uid;RADIUS_RU_UID_ATTR_LABEL,
grpCheckinfo;RADIUS_RU_GRPCHECKINFO_ATTR_LABEL,
grpReplyinfo;RADIUS_RU_GRPREPLYINFO_ATTR_LABEL,
framedIPAddress;RADIUS_RU_FRAMEDIPADDRESS_LABEL;ipaddr,
userPassword;RADIUS_RU_USERPASSWORD_LABEL;crypt

RADIUS_RAS_ADD_COMMON=
iphostNumber;RADIUS_RAS_IPHOSTNUMBER_ATTR_LABEL;ipaddr,
sharedKey;RADIUS_RAS_SHAREDKEY_LABEL;crypt

RADIUS Profiles

Three RADIUS Remote User profiles are supplied in the default

Deja.properties file. There are no Remote Access Server profiles defined in the
defaultDeja.properties file. You can add more profiles, or add attributes to the
existing profiles, but you should not remove default attributes in the existing profiles.

RADIUS_RU_PROFILE RADIUS_RAS_PROFILE

Specifies the RADIUS profiles available in Deja. The default profiles are SLIP, PPP
and LOGIN. The syntax is:

RADIUS_RU_PROFILE= profile_name ; label , profile_name ; label
RADIUS_RAS_PROFILE= profile_name ; label , profile_name ; label
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Where:
profile_names the name of the profile
labelis the label that appears in the Create or Modify panels.

RADIUS_RU_ADIprofile_name RADIUS_RAS_ADIprofile_name

Defines the default attributes that are added to the entry automatically. The syntax is:
RADIUS_RU_ADDprofile_name = attribute  ; label ; input_type , ...
RADIUS_RAS_ADDprofile_name = attribute  ; label ; input_type , ...

Where:
attributeis the attribute you want automatically added to the entry definition
labelis the name to appear in the entry definition
input_types one of the four basic input typé#, string, crypt andipaddr). The
default input_type istring.
The following code example is an extract of Beja.properties file showing
the RADIUS Profile Definitions:
# Profiles defined for Remote Users (RU)

RADIUS_RU_PROFILE= ppP_p;RADIUS_RU_PPP_PROFILE_LABEL,
slip_p;RADIUS_RU_SLIP_PROFILE_LABEL,
login_p;RADIUS_RU_LOGIN_PROFILE_LABEL

# Mandatory RU profile attributes (you can edit the next line by ADDING
attributes, but

# NEVER erase the attributes that are given by default)

RADIUS_RU_ADD.ppp_p=
radiuspppprofile;RADIUS_RU_RADIUSPPPPROFILE_ATTR_LABEL;int,
radiusPppPasswd;RADIUS_RU_RADIUSPPPPASSWD_ATTR_LABEL;crypt

RADIUS_RU_ADD.slip_p=
radiusSlipprofile;RADIUS_RU_RADIUSSLIPPROFILE_ATTR_LABEL;int,
radiusSlipPasswd;RADIUS_RU_RADIUSSLIPPASSWD_ATTR_LABEL;crypt

RADIUS_RU_ADD.login_p=
radiusLoginprofile;RADIUS_RU_RADIUSLOGINPROFILE_ATTR_LABEL;int,
radiusLoginPasswd;RADIUS_RU_RADIUSLOGINPASSWD_ATTR_LABEL;crypt

# Profiles defined for Remote Access Servers (RAS)

#RADIUS_RAS_PROFILE= no defined profiles
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# Mandatory RAS profile attributes
#RADIUS_RAS_ADD.??= no defined profiles
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Chapter

RADIUS/LDAP Information Mapping

This chapter describes how RADIUS information is stored in the LDAP directory. It
provides a list of RADIUS object classes and attributes, and shows the mapping
between a RADIUS dictionary and directory objects.

This chapter contains the following sections:
» “Attribute Mapping” on page 87

* “RADIUS Schema” on page 91

Attribute Mapping

The RADIUS attributes and values defined in all of the dictionary files provided with
the Solaris Extensions for Netscape Directory Server 4.11 are mapped onto LDAP
attributes. This mapping is defined in tiaglius.mapping file located in
/etc/opt/SUNWconn/Idap/current/mapping

There is a one-to-one correlation between RADIUS attributes and LDAP attributes.
Therefore, the mapping syntax is very simple. You can easily add proprietary
RADIUS attributes to the default mapping.

A copy of the defaultadius.mapping file is stored in the directory
/opt/SUNWconn/Idap/default . You should keep this file as a reference copy,
and not modify it.
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Default Mapping

Table 4.1 shows the one-to-one correspondence between RADIUS attributes and
LDAP attributes. The table also indicates the origin of each RADIUS attribute. There
are several kinds of RADIUS attributes:

» Standard attributes
* Vendor-specific attributes

« Attributes defined by the Solaris Extensions for Netscape Directory Server 4.11
product

Standard RADIUS attributes are specified in RFC 2R88ote Authentication Dial

In User Service (RADIUZNd RFC 213RADIUS Accountingvendor-specific
attributes are defined by NAS vendors and supplied in the dictionary file they provide
with their equipment. There aren’t any vendor-specific attributes in the dictionary file
provided with Solaris Extensions for Netscape Directory Server 4.11.

The LDAP attributes that allow the Netscape Directory Server to store RADIUS
information in the directory database are defined irrtitbus.at.conf file. This
file is stored in théopt/SUNWconn/ldap/default/schema directory.

The LDAP object classes that allow the Netscape Directory Server to store RADIUS
information in the directory database are defined inritus.oc.conf file. This
file is also stored in thept/SUNWconn/ldap/default/schema directory.

The purpose of all RADIUS attributes and object classes is described in “RADIUS
Schema” on page 91.

Table 4.1 RADIUS-to-LDAP Attribute Mapping

RADIUS Attribute Origin LDAP Attribute
User-Name RFC 2138 uid

Crypt-Password Solaris Extensions userPassword
CHAP-Password RFC 2138 chapPassword
NAS-IP-Address RFC 2138 ipHostNumber
NAS-Identifier RFC 2138 authNASidentifier
NAS-Port RFC 2138 authHostPortNumber
Service-Type RFC 2138 authServiceProtocol
Framed-Protocol RFC 2138 framedProtocol
Framed-IP-Address RFC 2138 framedIPAddress
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Framed-IP-Netmask
Framed-Routing
Filter-1d
Framed-MTU
Framed-Compression
Login-IP-Host
Login-Service
Login-TCP-Port
Reply-Message
Callback-Number
Callback-1d
Framed-Route
Framed-IPX-Network
State
Session-Timeout
Idle-Timeout
Termination-Action
Called-Station-Id
Calling-Station-Id
NAS-Port-Type
Port-Limit
Acct-Status-Type
Acct-Delay-Time
Acct-Input-Octets
Acct-Input-Packets
Acct-Output-Octets
Acct-Output-Packets
Acct-Session-1d
Acct-Authentic
Acct-Session-Time
Acct-Terminate-Cause
Expiration

Origin
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2138
RFC 2139
RFC 2139
RFC 2139
RFC 2139
RFC 2139
RFC 2139
RFC 2139
RFC 2139
RFC 2139
RFC 2139

Solaris Extensions

Attribute Mapping

LDAP Attribute
ipNetmaskNumber
framedRouting
authFilterld
framedMTU
framedCompression
ipLoginHost
authLoginService
ipLoginPort
authReplyMessage
userCallbackNumber
userCallbackld
framedRoute
ipxNetworkNumber
authState
sessionTimeoutNumber
idleTimeoutNumber
authTerminationAction
authCalledStationld
authCallingStationld
authHostPortType
authPortLimit
acctStatusType
acctDelayTime
acctinputOctet
acctinputPacket
acctOutputOctet
acctOutputPacket
acctSessionld
acctAuthentic
acctSessionTime
acctTerminateCause
expirationDate
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RADIUS Attribute
Auth-Type

Menu
Termination-Menu
Prefix

Suffix

user-check
user-reply
Login-Profile
PPP-Profile
SLIP-Profile
Login-Passwd
PPP-Passwd
SLIP-Passwd
Login-Expiration
PPP-Expiration
SLIP-Expiration
Auth-Failed-Access
Dynamic-Session-Counter
Dynamic-Sessionld
Dynamic-IPAddress
Dynamic-IPAddr-Binding
Dictionary-File
AcctAttr-File
PAM-Service-Name

Origin
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions
Solaris Extensions

LDAP Attribute
authType
authStartMenuld
authStopMenuld
authPrefixName
authSuffixName
grpCheckinfo
grpReplyinfo
radiusLoginProfile
radiusPppProfile
radiusSlipProfile
radiusLoginPasswd
radiusPppPasswd
radiusSlipPasswd
radiusLoginExpiration
radiusPppExpiration
radiusSlipExpiration
radiusAuthFailedAccess
dynamicSessionCounter
dynamicSessionld
dynamiclPAddress
DynamiclPaddrBinding
dictionaryFile
acctattrFile

pamServiceName

Extending the Default Mapping

You can change the default mapping provided irrdldéus.mapping

file to suit

your own needs. To extend the default mapping to add RADIUS attributes that are not
included in the default mapping, you must create a RADIUS/LDAP mapping
definition.
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To create a RADIUS/LDAP mapping definition:

1. Create an LDAP attribute for each missing RADIUS attribute.

For information on this task, refer to tNetscape Directory Server
Administrator’'s Guide

2. Add the RADIUS-LDAP attribute pair to the
/etc/opt/SUNWconn/Idap/current/radius.mapping file, using a
text editor.

Make sure you add it in both the Import section and the Export section of the file.
You need to be logged in esot  to perform this operation.

3. Restartthens-slapd daemon so that the modifications to the schema are taken
into account.

4. Restart thalsradiusd daemon so that the new mapping file is taken into
account. Agoot , type the following commmands:

# lopt/SUNWconn/ldap/shin/dsradius stop

# lopt/SUNWconn/ldap/sbin/dsradius start

5. Run thedejasync utility. Asroot type:

# lopt/SUNWconn/ldap/shin/dejasync

For details on the options of thejasync  utility, refer to “dejasync” on page
121. You must rudejasync if you want to use the Deja tool to modify
RADIUS entries in the directory.

Note You can modify an existing RADIUS object class to add a new attribute. However,
the best approach is to create a sub-class of an existing object class to hold the new
attribute.

RADIUS Schema

This section describes the RADIUS schema. It lists the object classes and attributes
that are required to use the RADIUS service. The RADIUS schema is automatically
added to the directory server schema when you run the RADIUS initialization script,
setup_rad , as described in “Initializing RADIUS” on page 21.
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RADIUS Object Classes

RADIUS object classes are defined in thdius.oc.conf file . This file is
located in thdopt/SUNWconn/ldap/default/schema directory.

The RADIUS service includes the following specific object classes:

* nas: used to create NAS entries in the directory database
* remoteUser: used to create remote user entries in the directory database
» radiusServer: used to describe hosts that are RADIUS servers

nas

Description: Defines a Network Access Server used in the context of RADIUS
authentication.

Superior object class: device
Mandatory attributes: iphostNumber, sharedKey

Optional attributes: acctattrFile, dictionaryFile

remoteUser

Description: In the context of RADIUS authentication, used to define remote users
who access the network through a Network Access Server (NAS). The remoteUser
object class is an auxiliary object class. This means that it can be used with any
structural object class, for example the person or organizational person object class.
The uid attribute is mandatory because it is always passed in the connection request
transmitted by the NAS to the RADIUS server. It is the key attribute used in the
search filter applied by the RADIUS server to look for the remote user’s entry in the
directory. The optional attributes are the LDAP translation of the RADIUS attributes.
They define all the possible connection parameters that can be passed in a connection
request transmitted by the NAS to the RADIUS server.

Superior object class: top
Mandatory attribute: uid (userid)

Optional attributes: acctAuthentic, acctDelayTime, acctinputOctet, acctinputPacket,
acctOutputOctet, acctOutputPacket, acctSessionld, acctSessionTime, acctStatusType,
acctTerminateCause, authCalledStationld, authCallingStationld, authFilterld,
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authHostPortNumber, authHostPortType, authLoginService, authNASidentifier,
authPortLimit, authPrefixName, authReplyMessage, authServiceProtocol, authType,
authStartMenuld, authState, authStopMenuld, authSuffixName,
authTerminationAction, chapPassword, cn (commonName), dynamicSessionCounter,
dynamicSessionld, dynamiclPAddress, dynamiclPaddrBinding, expirationDate,
framedCompression, framedIPAddress, framedMTU, framedRoute, framedRouting,
framedProtocol, grpCheckinfo, grpReplyinfo, idleTimeoutNumber, ipHostNumber,
ipLoginHost, ipLoginPort, ipNetmaskNumber, ipxNetworkNumber,
pamServiceName, radiusLoginProfile, radiusPppProfile, radiusSlipProfile,
radiusAuthFailedAccess, radiusLoginExpiration, radiusLoginPasswd,
radiusPppExpiration, radiusPppPasswd, radiusSlipExpiration, radiusSlipPasswd,
sessionTimeoutNumber, userCallbackld, userCallbackNumber, userPassword.

radiusServer
Description: This object class is reserved for future use.
Superior object class: applicationProcess

Mandatory attributes: host, sharedKey

Optional attributes: dictionaryFile, acctattrFile, authHostPortNumber,
acctHostPortNumber, radiusServerRealm, radiusServerFlags

RADIUS Attributes

RADIUS attributes are defined in thadius.at.conf file. This file is located in
the/opt/SUNWconn/ldap/default/schema directory.

All attributes defined in the RADIUS schema have one of the following syntaxes:

« Distinguished name (dn)

» Case-ignore string (cis); An alphanumeric string, not case-sensitive
» Case-exact string (ces); A case-sensitive alphanumeric string

e Telephone number (tel)

» Integer (int or long)

* Binary (bin)

e UTC time (utctime)
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The following list of attributes in the RADIUS schema gives the attribute syntax, any
alternative names, and explains how the attribute is used.
acctattrFile

Description: Specifies the name of the dynamic accounting attributes file to be used to
interpret the dynamic accounting information received from the NAS described by the
entry.

Syntax: ces

Contained in object class: nas, radiusServer

acctAuthentic

Description: Used in RADIUS accounting requests to indicate how the user described
by the entry was authenticated.

Syntax: ces

Contained in object class: remoteUser

acctDelayTime

Description: Used in RADIUS accounting requests to indicate for how long the NAS
has been trying to send an accounting report. The delay is deducted from the time of
arrival of the report to determine the actual time at which the event occurred.

Syntax: ces

Contained in object class: remoteUser

acctinputOctet

Description: Used in RADIUS accounting requests to indicate the number of octets
received during the provision of service.

Syntax: ces

Contained in object class: remoteUser
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acctinputPacket

Description: Used in RADIUS accounting requests to indicate the number of packets
received during the provision of service.

Syntax: ces

Contained in object class: remoteUser

acctOutputOctet

Description: Used in RADIUS accounting requests to indicate the number of octets
sent during the provision of service.

Syntax: ces

Contained in object class: remoteUser

acctOutputPacket

Description: Used in RADIUS accounting requests to indicate the number of packets
sent during the provision of service.

Syntax: ces

Contained in object class: remoteUser

acctSessionld

Description: Used in RADIUS accounting to provide a unique accounting ID. It is
used to match start and stop records for the same session.

Syntax: ces

Contained in object class: remoteUser
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acctSessionTime

Description: Used in RADIUS accounting to indicate the number of seconds during
which the user described by the entry has received service.

Syntax: ces

Contained in object class: remoteUser

acctStatusType

Description: Used in RADIUS accounting to indicate whether the current report
marks the beginning of service (start) or the end (stop).

Syntax: ces

Contained in object class: remoteUser

acctTerminateCause
Description: Used in RADIUS accounting to indicate how a session was terminated.
Syntax: ces

Contained in object class: remoteUser

authCalledStationld

Description: Indicates the phone number called by the user to request access through a
NAS.

Syntax: ces

Contained in object class: remoteUser

authCallingStationld

Description: Indicates the phone number from which the user called to request access
through a NAS.

Syntax: ces

Contained in object class: remoteUser
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authFilterld
Description: Indicates the name of the filter list for the user described by the entry.
Syntax: ces

Contained in object class: remoteUser

authHostPortNumber

Description: Indicates the physical port number of the NAS that is authenticating the
user.

Syntax: ces

Contained in object classes: remoteUser, radiusServer

authHostPortType

Description: Indicates the type of physical port number of the NAS that is
authenticating the user.

Syntax: ces

Contained in object class: remoteUser

authLoginService

Description: Indicates the service that should be used to connect the user to the login
host.

Syntax: ces

Contained in object class: remoteUser

authNASidentifier

Description: Contains a string that identifies the NAS that transmitted an access
request.

Syntax: ces

Contained in object class: remoteUser
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authPortLimit

Description: Sets the maximum number of ports to be provided by the NAS to the
user.

Syntax: ces

Contained in object class: remoteUser

authPrefixName

Description: Used internally by the RADIUS server to distinguish between the user
name to be processed for authentication and a possible prefix. In some cases, the
connection protocol can add a prefix to the user’'s name, for example, ppp%jsmith.

Syntax: ces

Contained in object class: remoteUser

authReplyMessage
Description: Contains text that the NAS can display to the user.
Syntax: cis

Contained in object class: remoteUser

authServiceProtocol
Description: Indicates the type of service requested by the user.
Syntax: ces

Contained in object class: remoteUser

authStartMenuld
Description: This attribute is used internally by the RADIUS server.
Syntax: ces

Contained in object class: remoteUser
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authState

Description: A state attribute sent by the RADIUS server to the NAS. The NAS must
send it back unchanged in the reply to the server. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

authStopMenuld
Description: Used internally by the RADIUS server.
Syntax: ces

Contained in object class: remoteUser

authType

Description: Indicates to the RADIUS server how passwords are stored, so that the
password supplied by the user can be compared correctly against the password stored
under the user’s entry in the directory. Possible values for this attribute are:

» Crypt-Local - Specifies that passwords are stored encrypted
» Local - Specifies that passwords are stored in clear text

» System- Specifies that passwords are maintaingddttipasswd
Syntax: ces

Contained in object class: remoteUser

authSuffixName

Description: Used internally by the RADIUS server to distinguish between the user
name to process for authentication and a possible suffix. In some cases, the domain
name can be added to the user's name, for example, jsmith@eng.xyz.com.

Syntax: ces

Contained in object class: remoteUser
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authTerminationAction

Description: Indicates the action to perform by the NAS when the service session is
finished.

Syntax: ces

Contained in object class: remoteUser

chapPassword

Description: Contains the response value provided by a PPP Challenge Handshake
Authentication Protocol (CHAP) user in response to a challenge. This attribute is
single-valued.

Syntax: ces

Contained in object class: remoteUser

dictionaryFile

Description: Specifies the dictionary to be used by the RADIUS server when it
receives a request from the NAS described by the entry.

Syntax: ces

Contained in object class: nas, radiusServer

dynamiclPaddressBinding

Description: When RADIUS accounting is activated, associates the
dynamiclPAddress and the dynamicSessionld assigned to the remote user.

Syntax: cis

Contained in object class: remoteUser
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dynamiclPaddress

Description: When RADIUS accounting is activated, the IP address assigned to the
remote user is recorded in the user’s entry using this attribute. This attribute is created
when the session begins, and removed when the session ends.

Syntax: cis

Contained in object class: remoteUser

dynamicSessionCounter

Description: When RADIUS accounting is activated, the number of concurrent open
sessions for a remote user is recorded in the user’s entry using this attribute. This
attribute is removed when the user ends the last session. This attribute is
single-valued.

Syntax: int

Contained in object class: remoteUser

dynamicSessionld

Description: When RADIUS accounting is activated, the session identifier assigned to
the remote user for a particular session is recorded in the user’s entry using this
attribute. This identifier is used in to open and close the accounting report for the
session.

Syntax: cis

Contained in object class: remoteUser

expirationDate

Description: Indicates the expiration date for the password stored in the userPassword
attribute. The expirationDate attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser
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framedCompression
Description: Indicates a compression protocol to be used for the link.
Syntax: ces

Contained in object class: remoteUser

framedIPAddress
Description: Indicates the address to be configured for the user.
Syntax: ces

Contained in object class: remoteUser

framedMTU

Description: Indicates the maximum transmission unit (MTU) to be configured for the
user, when it is not negotiated by some other means (such as PPP).

Syntax: ces

Contained in object class: remoteUser

framedProtocol
Description: Indicates the framing to be used for framed access.
Syntax: ces

Contained in object class: remoteUser

framedRoute

Description: Provides routing information to be configured for the user on the NAS.
Not to be confused with the framedRouting attribute.

Syntax: ces

Contained in object class: remoteUser
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framedRouting

Description: Indicates the routing method for the user, when the user is a router to a
network. Not to be confused with the framedRoute attribute.

Syntax: ces

Contained in object class: remoteUser

grpCheckinfo

Description: Contains a list of attributes (except uid) that must be checked by the
RADIUS server against the information supplied by the remote user. If this attribute is
not present, then access is denied. This attribute is used internally by the server.

Syntax: ces

Contained in object class: remoteUser

grpReplylnfo

Description: Contains a list of attributes returned by the RADIUS server with an
access-accept or access-reject response. It can contain connection parameters such as
a PPP or SLIP profile. If this attribute is not present, the remote user can connect from
any host or IP address, and through any connection protocol. This attribute is used
internally by the server.

Syntax: ces

Contained in object class: remoteUser

idleTimeoutNumber

Description: Sets the maximum number of consecutive seconds that the connection
can remain idle before the session is terminated.

Syntax: ces

Contained in object class: remoteUser
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ipLoginHost

Description: Indicates the system with which to connect the user, when the
authLoginService attribute is included in the connection request.

Syntax: cis

Contained in object class: remoteUser

ipLoginPort

Description: Indicates the TCP port with which the user is to be connected, when the
authLoginService attribute is included in the connection request.

Syntax: cis

Contained in object class: remoteUser

ipxNetworkNumber
Description: Indicates the IPX network number to be configured for the user.
Syntax: cis

Contained in object class: remoteUser

pamServiceName

Description: Specifies the name of the service that provides the PAM module. If you
want to use PAM authentication with the RADIUS server, set the value of this
attribute to beadius. You must also adpamServiceNameto the list of attributes in

the grpCheckinfo attribute. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser
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radiusAuthFailedAccess

Description: Created dynamically in a remote user’s entry when an access request is
rejected. This counter is incremented by 1 at each failed attempt. The user account is
blocked when this counter reaches the blocking value specified in the configuration
(by default, 4). This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusLoginExpiration

Description: Indicates the expiration date for the password stored in the
radiusLoginPasswd attribute. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusLoginPasswd

Description: Password provided by the remote user to gain access to the network
through the LOGIN protocol. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusLoginProfile

Description: Flag with value 0 or 1. Value 1 enables checking of the password
supplied by the user against the password stored in the radiusLoginPasswd attribute.
Value 0 disables this check. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser
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radiusPppExpiration

Description: Indicates the expiration date for the password stored in the
radiusPppPasswd attribute. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusPppPasswd

Description: Password provided by the remote user to gain access to the network
through the PPP protocol. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusPppProfile

Description: Flag with value 0 or 1. Value 1 enables checking of the password
supplied by the user against the password stored in the radiusPppPasswd attribute.
Value 0 disables this check. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusServerFlags
Description: Reserved for future use.
Syntax: ces

Contained in object class: radiusServer

radiusServerRealm
Description: Reserved for future use.
Syntax: ces

Contained in object class: radiusServer
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radiusSlipExpiration

Description: Indicates the expiration date for the password stored in the
radiusSlipPasswd attribute. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusSlipPasswd

Description: Password provided by the remote user to gain access to the network
through the SLIP protocol. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

radiusSlipProfile

Description: Flag with value 0 or 1. Value 1 enables checking of the password
supplied by the user against the password stored in the radiusSlipPasswd attribute.
Value 0 disables this check. This attribute is single-valued.

Syntax: ces

Contained in object class: remoteUser

sessionTimeoutNumber

Description: Sets the maximum number of seconds of service to be provided to the
user described in the entry before the session is shut down.

Syntax: ces

Contained in object class: remoteUser
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sharedKey

Description: Specifies the shared secret used by the network access server (NAS)
described by the entry during RADIUS authentication. This attribute is single-valued.

Syntax: ces

Contained in object classes: nas, radiusServer

userCallbackld

Description: Indicates a name of a place to be called. This attribute is interpreted by
the NAS.

Syntax: ces

Contained in object class: remoteUser

userCallbackNumber

Description: Indicates a dialing string to use for callback to provide service to the
user.

Syntax: ces

Contained in object class: remoteUser

userid

Description: The uid, or userid (mandatory), is always passed in the connection
request transmitted by the NAS to the RADIUS server. It is the key attribute used in
the search filter applied by the RADIUS server to look for the remote user’s entry in
the directory.

Syntax: cis

Contained in object class: remoteUser
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userPassword

Description: The password that the user described by the entry uses to gain access to
the entry. This password is automatically encrypted by the directory server.

Contained in object class: remoteUser
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Chapter

Command & File Reference

This chapter describes the daemons, commands and files that provide RADIUS
service.

Synopsis

The location of thecctattr file is:

letc/opt/SUNWconn/Idap/current/acctattr

Description

Theacctattr  file contains a list of RADIUS attributes that are recorded for each
remote connection when dynamic accounting is enabled. The attributes listed in this
file are recorded in the directory entry of the remote user.

The RADIUS attributes listed in treectattr  file must belong to the dictionary
file supported by the NAS.
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Other accounting parameters that are automatically recorded when dynamic
accounting is enabled are:

e dynamiclPaddress

» dynamicSessionld

» dynamicSessionCounter

e dynamiclPaddressBinding

If you add attributes to thecctattr  file, you must ensure that there is a
corresponding LDAP attribute for each RADIUS attribute. The mapping of the
RADIUS attribute to the LDAP attribute must be declared inrddius.mapping
file.

See Also

See “dictionary” on page 123, “radius.mapping” on page 134

Deja.properties

Synopsis

The location of th®eja.properties file is:

lopt/SUNWconn/Idap/html/Deja.properties

Description

The Deja.properties file determines the display characteristics of Deja. It also
defines the templates that are used to create and modify certain directory entries, such
as NIS and RADIUS entries.

You must be authenticated sigperuser  orroot to modify the
Deja.properties file. When you have made modifications to this file, you must
restart Deja for the modifications to take effect.
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File Structure

The Deja.properties file consists of four sections:
» “General Properties” on page 114

» “Standard LDAP Properties” on page 115

* “NIS Properties” on page 117

» “RADIUS Properties” on page 119

File Syntax

Each section in thBeja.properties file contains a list of definitions. Each
definitition ends with a carriage return. The different elements in a definition are
separated by commas. Related elements are separated by semi-colons.

For example, the attributes returned in RADIUS searches are defined as follows:

RADIUS_RU_LIST.default=" cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL

In this example, the definition is composed of two elements, separated by a comma.
Each element consists of an attribute type (cn and uid in this example), and a label that
is displayed in Deja, in the results table header row.

This example does not show the actual labels that appear in Deja’s menus. These are
defined separately, in thecalized resource bundl@he localized resource bundle
contains translations in every supported locale for the user interface of Deja.

Labels

Standard Deja labels and identifiers (parameters endingABEL, IDENTIFIER
or _CHOICE are defined in the localized resource bundle. You cannot change these
definitions. You can, however, create your own labels.

For example, if you want the ipHostNumber attribute type to be in the list returned by
default in a search on RADIUS remote users, you might modify the
RADIUS_RU_LIST.default  definition as follows:

RADIUS_RU_LIST.default=" cn;RADIUS_RU_CN_ATTR_LABEL,
uid;RADIUS_RU_UID_ATTR_LABEL, ipHostNumber;Host Number
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This definition is local to youDeja.properties file. It is not part of the
localized resource bundle.

User Input

In theDeja.properties file, user input is represented using the character
sequencg0} . For example, in a search filter, the definititan=*{0}*) specifies
that the search will result in entries for which cn contains the search string.

The character sequenfdefinition$} is used by Deja to define a user input
field in searches. The expressidefinition , can consist of the following
elements:

» Attribute name - the type of attribute you are searching for
» Label - a text string to appear by the input field

» Field type - the type of input field required. The field type can have one of the
following values:crypt, string, int oripaddr. crypt is a text field where each
typed character is replaced withstring is a text field that accepts any character.
int is a text field that accepts only integer numheesddr consists of foumt
fields.

If Field type is not specified, the string input field is used by default. For example, the
following expressiod$iphostnumber;IP Host Number;ipaddr$}

generates an ipaddr input field with the label IP Host Number. It also specifies that
the user input is an attribute of the type iphostnumber.

General Properties

SCHEMA_THREAD_TIME_LIMIT
Defines a time limit in milliseconds on the time it takes Deja to read the schema.
The default value is no time limit.

BROWSER_ENTRY_LIMIT

Specifies the maximum number of entries that can be displayed in the browser. If
a limit has been set, you must refresh certain subtrees before opening more. The
default value is no limit.
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BROWSER_SUBENTRY_LIMIT
Defines the maximum number of immediate children of an entry that can be
displayed in the browser. The default value is no limit.
BROWSER_LOAD_SUBNODES_TIME_LIMIT
Specifies the maximum amount of time allowed for Deja to load the children of a
node when the node is opened in the browser. This is not the amount of time it
then takes to display those children. The default val@8,300milliseconds.
BROWSER_CHECK_NODE_TIME_LIMIT
This is the maximum time taken for Deja to verify whether an entry is a leaf or a
node. The default value 5000milliseconds.
STANDARD_SECURITY_AUTHENTICATION

Defines the standard authentication mechanism used in the login panel. The only
possible value for this parametesimple.

Standard LDAP Properties

In this section the following tokens are defined:

STANDARD_ATTRIBUTES_CRYPTED

In the View, Modify and Create windows of Deja, some attribute values are not
displayed, or replaced by a localized text string. You can specify the attributes
you want to be hidden by adding them to the
STANDARD_ATTRIBUTES_CRYPTHBY. Attribute names are separated by
commas. By default the values for userpassword, radiusppppasswd,
radiusloginpasswd, chappassword, and radiusslippasswd are hidden.

STANDARD_LOGIN_SEARCH_FILTER

The search feature of the login panel operates using the filter defined with this
label. By default it ig](cn=*{0}*)(uid=*{0}*)) . This search filter

means that either the cn attribute or the uid attribute should contain the search
string typed by the user in the search text field.

STANDARD_LOGIN_MAX_SEARCH_RESULT

Specifies the maximum number of search results per naming context returned by a
login search. The default value is 55.
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Note

STANDARD_LOGIN_ALIASES
Defines an alias for the user DN you use to login to Deja. By default, there are no

aliases defined, and tIB@ANDARD_LOGIN_ALIASE$arameter is commented
out. The definition in th®eja.properties file reads as follows:

# STANDARD_LOGIN_ALIASES= userA_alias; userA_dn; userB_alias; userB_dn
To add a login alias, you must uncomment the line, add an alias name and a user
DN for login. For example, if the user cn=Robert Travis,ou=sales,o=sun,c=us
wants to login frequently, you can create an alias for him, for example, rob. To add
this alias, you would edit tfeTANDARD_LOGIN_ALIASESlefinition in the
Deja.properties file to read as follows:

STANDARD_LOGIN_ALIASES= rob; cn=Robert Travis,ou=sales,0=sun,c=us

If you create several aliases, you must use a semi-colon to separate them, and not a
comma, which is the standard syntax, because the comma is used to separate the
different elements in the DN. The semi-colon separates the elements of a DN from a
new alias definition.
For example, if you also wanted to add an alias for the NIS administrator whose
DN is cn=NIS Manager, o=sun, c=us, SiEANDARD_ LOGIN_ALIASES
definition in theDeja.properties file would read as follows:
STANDARD_LOGIN_ALIASES= rob ; cn=Robert Travis,ou=sales,o=sun,c=us ; NIS
admin; cn=NIS Manager, o=sun, c=us
When Deja is restarted the aliases are available in the Login panel. This parameter
is case-sensitive.

STANDARD_SEARCH_FILTERS

Specifies the standard searches available in Deja. Each entry in this list is defined
on a separate line.

STANDARD_SEARCH_FILTERiame

Defines each search available, whesieneis the name of the search specified in
STANDARD_SEARCH_FILTER® search definition consists of the search
name (for example&STANDARD _SEARCH_FILTER_PERSOtMe label that
appears in the Search Type option button (for example,
STANDARD_SEARCH_FILTER_PERSON_IDENTIFIBRand the search
definition (for example(&(objectclass=*)(cn=*{0}*)) ).

STANDARD_SEARCH_TABLE_LABELS

Contains a list of the attributes and header labels for the search results table. By
default the cn, telephoneNumber and mail attributes are listed.
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STANDARD_CREATE_PASTE_CLEAR_DATA
When you paste an entry to the Create panel, the paste works in one of two ways:

« The paste action can remove information from the Create panel before pasting
the entry.

« The paste action does not clear data from the Create panel before pasting.
This is useful when you want to create an entry that contains the
characteristics of two or more entries.

This property specifies the type of paste. It can be $aidoor false true
indicates that data is cleared from the entry before pasting. By default this
parameter is set false The lines in thé®eja.properties file that define
this property are as follows by default:

# Standard Create
STANDARD_CREATE_PASTE_CLEAR_DATA=FALSE
#STANDARD_CREATE_PASTE_CLEAR_DATA=TRUE

To change the setting, uncomment the line you want, and comment out the other.

NIS Properties

NIS_MAPS

Specifies the list of maps available in Deja. Each map name is followed by a
semicolon and the label that appears in the Map Name option button of the NIS
Search, Create or Modify panels. If you create a new map mgheapping

file, you must declare the map name inkh8_MAPStoken in the

Deja.properties file. The syntax is:

NIS_MAPS= map.name; map_label , map.name; map_label ,

NIS_FILTER. map.name

Specifies the filter that is used in the NIS Search panel. This definition is
automatically generated by runnidgjasync

NIS_DOMAIN. map.name

Specifies the label that appears in the NIS Create, Modify and Search panels. It
shows to which domain the NIS map applies. This definition is automatically
generated by runnindejasync
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NIS_NAMINGATTR.map.name

Specifies the naming attributes that are available in the NIS Create panel. This is a
comma separated list. This definition is automatically generated by running
dejasync

NIS_ROOT.map.name

Specifies the DN of the root entry used for NIS searches. It is also the default
parent entry displayed in the NIS Create panel. This definition is automatically
generated by runnindejasync

NIS_OCLASS. map.name

Specifies the default object classes that are added to an entry definition in the NIS
Create Panel. This is a comma separated list. This definition is automatically
generated by runningejasync

NIS_LIST. map.name
Contains names of the attributes and header labels for the NIS search results table.
The syntax is:

NIS_LIST. map.name= attribute ; header_label |, attribute ; header_label

NIS_ADD. map.name
Specifies labels and syntax for attributes in the NIS Create panel. The syntax is:

NIS_ADD. map.name= attribute  ; label ; syntax , attribute ; label ; syntax ,

Where syntax is one of the four basic input types,(string, crypt andipaddr).
If a syntax isn't specified, the default valistring, is used. Specifying a syntax is
useful to constrain user input:

« crypt is a text field where each character typed in is replaced with *.
e string is a text field that accepts any character.

« int is a text field that accepts only integer numbers.
e ipaddr consists of foumt fields, in the formaint.int.int.int.

NIS_LIST.default

Contains the names of the attributes listed in the NIS search results table if
NIS_LIST is not defined for a map.
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RADIUS Properties

RADIUS_RU_SEARGCHRADIUS_RAS_SEARCH

Specifies the standard searches available in Deja for remote users (RU) and
remote access servers (RAS). Each entry in this list is defined on a separate line.
The syntax is:

RADIUS_RU_SEARCH=Name label , Name label
WhereNameis the name of the search, dallel is the text that appears in the
Search Type option button.
RADIUS _RU_FILTER. Name RADIUS_RAS FILTER. Name
Defines the search filter used in the search, whem@eis the name of the search
specified iIRADIUS_RU_SEARCHr RADIUS RAS SEARCH
RADIUS_RU_LIST. Name RADIUS_RAS_LIST. Name
Contains a list of the attributes and header labels for the search results table.

RADIUS_RU_LIST. default ,RADIUS_RAS_LIST. default

Contains the default list of the attributes and header labels for the search results
table if aRADIUS_RU_LIST. Nameor RADIUS_RAS_LIST. Namedefinition
does not exist for the search.

RADIUS_COMPLEX_SEARCH_LIST
Contains a list of the attributes and header labels for the complex searches results
table.

RADIUS_RU_ADD_COMMG®MDIUS_RAS_ADD_COMMON

Specifies alternative names for attributes that are displayed in the Choose
Attributes list of the RADIUS Create panel. The syntax is:

RADIUS_RU_ADD_COMMON#tribute ; label ; type

Whereattribute is the name of an attributepel is the name you want to appear
in the Choose Attributes list, arigpeis the input type. You can restrict user input
to one of the four basic input typest( string, crypt oripaddr). The default
type isstring.
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RADIUS_RU_PROFILERADIUS_RAS_PROFILE
Three RADIUS Remote User profiles are defined in the default

Deja.properties file. You can add more profiles, or add attributes to the
existing profiles, but you should not remove default attributes in the existing
profiles.

RADIUS_RU_PROFILEand RADIUS_RAS_PROFILEspecify the RADIUS
profiles available to Deja. The default profiles are SLIP, PPP and LOGIN. The
syntax is:

RADIUS_RU_PROFILE= profile_name ; label , profile_name ; label

Whereprofile_namas the name of the profile, atabel is the label that appears
in the Create or Modify panels.

RADIUS_RU_ADDName RADIUS_RAS_ADDName

Defines the default attributes that are added to the entry automatically. The syntax
is:

RADIUS_RU_ADD.profile_name=  attribute  ; label ; input_type

Whereattribute is the attribute you want automatically added to the entry
definition,labelis the name to appear in the entry definition, amlit_types one

of the four basic input types (int, string, crypt or ipaddr). The default input_type is
string.

RADIUS_RU_OCLASS

Specifies the object class associated with the RADIUS remote user entry type. A
single object class is required for each type. This definition is automatically
updated if you use thaejasync utility. The default object class is remoteUser.

RADIUS_RAS_OCLASS

Specifies the object class associated with the RADIUS remote access server entry
type. A single object class is required for each type. This definition is
automatically updated if you use ttiejasync utility. The default object class

is nas.

RADIUS_RU_ROOT

Specifies the DN of the root entry used for RADIUS remote user searches. It is
also the default parent entry displayed in the RADIUS Create panel. This
definition is automatically updated if you use tlegasync  utility. The default
value iso=airius_remote_users,c=us
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RADIUS_RAS_ROOT

Specifies the DN of the root entry used for RADIUS remote access server
searches. Itis also the default parent entry displayed in the RADIUS Create panel.
This definition is automatically updated if you usedegsync utility. The

default value i®=airius_ras,c=us

RADIUS_RU_NAMINGATTR
Specifies the naming attributes that are available in the RADIUS Create panel for
remote user entries. This is a comma separated list. The default naming attributes
are cn and uid.

RADIUS_RAS_NAMINGATTR
Specifies the naming attributes that are available in the RADIUS Create panel for
remote access server entries. This is a comma separated list. The default naming
attribute iscn.

RADIUS_MAX_FAIL

Specifies the search limit for the RADIUS remote user blocked accounts search.
The blocked accounts search returns entries that have a value for the attribute
radiusAuthFailedAccess that is greater than or equal to the value of
RADIUS_MAX_FAIL. The default value i&. This definition is automatically
updated if you use thaejasync  utility.

See Also

See “dejasync” on page 121, “radius.mapping” on page 134

Synopsis

The command syntax falejasync is:

/opt/SUNWconn/ldap/shin/dejasync [-v] [-d Deja_properties_directory ]
[-n  NIS_mapping_file  ][-r RADIUS_mapping_file ]
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Description

dejasync is a command line utility that synchronizes bBeja.properties

files with the NIS and RADIUS mapping filesi¢.mapping and

radius.mapping ) on the directory server. Use it when you have made
modifications to the mapping files and you want the changes to be carried over into

Deja.
It creates or updates tokens in eja.properties file and also backs up the
Deja.properties file.

You must be logged in asot orsuperuser to rundejasync

nis.mapping  File

Thedejasync command gets the list of NIS maps managed by Deja from the
Deja.properties file. These are lines that start with th&s_ MAPStoken.

For each map in thBeja.properties file, dejasync creates a new map
definition by copying the following tokens from thes.mapping file into the
Deja.properties file:

* NIS_FILTER

* NIS_DOMAIN

e NIS_ROOT

« NIS_NAMINGATTR
« NIS_OCLASS

If these tokens exist in tH2eja.properties file, thedejasync command
updates them. If they do not exist, it creates them.

radius.mapping File

When synchronizingpeja.properties with theradius.mapping file,
dejasync copies the Max_allowed_failures, base-DN and FILTER tokens from the
radius.mapping file to theDeja.properties file:

« RADIUS_RU_OCLASS

« RADIUS_RAS_OCLASS
« RADIUS_RU_ROOT

« RADIUS_RAS_ROOT
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If these tokens exist in thH2eja.properties
exist it creates them.

Options

-V

-d

Enables verbose mode.

Deja_properties_directory

dictionary

file it updates them. If they do not

Specifies the directory containing theja.properties file. By default this

is /opt/SUNWconn/Idap/html

NIS_mapping_file

Specifies the filename of the NIS mapping file. By default this is
letc/opt/SUNWconn/Idap/current/mapping/nis.mapping

RADIUS_mapping_file

Specifies the filename of the RADIUS mapping file. By default this is
/etc/opt/SUNWconn/Idap/current/mapping/radius.mapping

See Also

See “radius.mapping” on page 134, and “Deja.properties” on page 112

dictionary

Synopsis

The location of thelictionary file is:

letc/opt/SUNWconn/Idap/current/dictionary
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Description

Thedictionary file is used for communication between the RADIUS server and
the NAS. A RADIUS dictionary file contains RADIUS attribute and value pairs. A
number of these attributes are defined in RFC R&8ote Authentication Dial In
User Service (RADIUSaNd RFC 213RADIUS AccountingHowever, NAS vendors
have also defined proprietary attributes.

Thedictionary file contains standard RADIUS attribute definitions and
non-protocol attributes that are used internally by the RADIUS server. Internal
attributes are listed in Table 2.1 on page 35.

Dictionary files are often provided by NAS vendors such as Ascend, Cisco, Shiva or
Bay Networks. Solaris Extensions for Netscape Directory Server 4.11 can be also be
used with these vendor-supplied dictionaries.

dsnmpcfg

Synopsis

The syntax of thelsnmpcfg command is:

lopt/SUNWconn/ldap/sbin/dsnmpcfg { install | configure | remove }

Description

Thedsnmpcfg script is used by thgkgadd utility to initialize thedsnmprad
daemon provided with Solaris Extensions for Netscape Directory Server 4.11. It is
also used by thekgrm utility to stop the daemon. Thisnmprad daemon is an
SNMP agent that collects statistics on RADIUS traffic.

Thedsnmpcfg script is also used by to declare the hosts to which the SNMP agent
must send SNMP traps. It does this by modifyingttap-recipients variable
in thedsnmprad.conf file.
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Options

install

Called bypkgadd when the SUNWSsds package is installed to generate the initial
SNMP configuration. It creates the configuration fismmprad.conf if it does
not already exist. It then starts the RADIUS SNMP daemsmmnprad .

configure

Used by the administrator to configure the SNMP configuration file,
dsnmprad.conf . The administrator is prompted to provide the names of the
hosts to which the SNMP daemon must send SNMP events (traps). when the
configuration is complete, tlilsnmpcfg script restarts the SNMP daemon
dsnmprad .

remove

Called bypkgrm when the SUNWsds package is removed to remove the SNMP
configuration. It stopdsnmprad , then removes thgsnmprad.conf  file and
the log files.

See Also

See “dsnmprad” on page 125

dsnmprad

Synopsis

The syntax of thelsnmprad daemon is:

lopt/'SUNWconn/Idap/lib/dsnmprad [-h] [-a target-agent-host 1[-b
boots-file 1 [-c  config-file ] [ poll-interval 1 [ log-file ] [-p port ]
[-s log-size ] [-t timeout ] [-T  trace-level 1 [y internal-auth-port ][z

internal-acc-port ]
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Description

Thedsnmprad daemon is an SNMP agent that implements RFC BgIBIUS
Authentication Server MIBnd RFC 262RADIUS Accounting Server MIB

Thedsnmprad daemon implements the SNMGFETandGET-NEXTcommands. It
does not implement the SNMFET command.

Thedsnmprad configuration filesdsnmprad.conf ~ anddsnmprad.boots are
located by default in thietc/opt/SUNWconn/ldap/current directory. If

you move them to a new location, you must specify it on the command line (options
-b and-c ) when you startisnmprad .

Thedsnmprad daemon gets the list of manager hosts (recipients of SNMP traps)
from thedsnmprad.conf file.

Options

-h
Online help (usage).

-a target-agent-host
Default is localhost.

-b boots-file
The default boots file is
letc/opt/SUNWconn/Idap/current/dsnmprad.boots.
-c config-file

Specifies the configuration file containing the list of hosts that are recipients of
SNMP traps. The default file is
letc/opt/SUNWconn/Idap/current/dsnmprad.conf

-i poll-interval
Default poll interval is 10 seconds.

-l log-file
Default log file is'tmp/radiusd.log
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-p port

Indicates the UDP port number on which the SNMP agent listens for traps. The
default port number is 161.

-s log-size
Indicates the maximum size of the log file. The default value is 100,000 bytes.

-t timeout
Default timeout is 4000000 microseconds.

-T trace-level
The trace level parameter is in the range 0 to 4. The default value is 0.

-y internal-auth-port
Default is 34654.

-z internal-acc-port
Default is 34754.

See Also

See “dsnmpcfg” on page 124

Synopsis

The syntax of thélsradius  script is:

lopt/SUNWconn/ldap/sbin/dsradius { start | stop | refresh }
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dsradiusd

Description

Thedsradius  script can be used to start and stopddmadiusd daemon. Itis

also used to force thisradiusd  daemon to re-read the configuration without
stopping and restarting. You must perform a restart or a refresh dérdmtius

daemon whenever you change the RADIUS configuration, or when you add, delete or
modify NAS entries in the directory.

Options

start | stop | refresh

Use the appropriate keyword to start or stopd$dradiusd daemon. The
refresh keyword forcedsradiusd  to re-read thésradiusd.conf
configuration file, or to the NAS branch of the directory tree.

See Also

See “dsradiusd” on page 128, “dsradiusd.conf” on page 132

Synopsis

The syntax of thélsradiusd daemon is:

lopt/SUNWconn/Idap/lib/dsradiusd [-a acct_dir ][-c conf_file  ][-d
config_dir ][-f failed_password_blocking_number 1[-h] [-i ip_address ]
[-] [ log_file  ][-m  mapping file ][-0] [-p authentication_udp_port ]
[-P accounting_udp_port 1[-q max_outstanding_requests 1[-s] [-t
max_seconds_in_queue ] [-V] [-X trace-level 1y min_threads ][-z
max_threads |
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Description

Thedsradiusd daemon is the RADIUS server daemon. It is an authentication
server for remote users connecting to a network through a Network Access Server
(NAS), also called Remote Access Server (RAS), that uses Netscape Directory Server
to store information about remote users and NAS'’. The NAS communicates with
dsradiusd to check the information provided in the connection request against the
information stored in the directory.

RADIUS (Remote Access Dialup User Service) is the protocol used by the
dsradiusd daemon to authenticate remote users who connect to the network.

Thedsradiusd daemon also provides accounting information on remote user
connections. When the daemon is started, it forks two processes, one to handle
authentication, to other to handle accounting.

Thedsradiusd daemon can be started with theradius  script. The startup
parameters are saved in tlaglius.mapping file.

Options

-a acct_dir

Specifies the directory where accounting information is stored. The default is
Ivar/opt/SUNWconn/ldap/radacct . This directory contains one
subdirectory per NAS, named after the NAS hostname, or the NAS IP host
number.

-c conf_file

Specifies the name of the configuration file. The defadkriadiusd.conf

-d config_dir
Specifies the directory where the configuration file is stored. The default is
letc/opt/'SUNWconn/Idap/current

-f failed_password_blocking_limit

Specifies the number of times a wrong password can be supplied before the user
account is blocked. By default, the user account is blocked after four unsuccessful
attempts.
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-h

Displays the usage message.

ip_address

Specifies the IP address of the RADIUS server. Use this option if the IP address of
the host machine and of the RADIUS server are different, for example if the
RADIUS server runs on a machine that has multiple network interfaces.

Automatically adds dynamic connection attributes to the entry of the user when
an accounting-start signal is received. These attributes are removed when an
accounting-stop signal is received. The dynamic connection attributes are the
assigned IP address, accounting session ID, session counter (number of
simultaneous sessions opened by the same remote user), and all attributes listed in
acctattr . For this option to work, RADIUS accounting must be

activated. This means that the Network Access Server (NAS) must be configured
to send accounting packets to the RADIUS server.

log_file

Specifies the file where logging information is saved. The default is
Ivar/lopt/SUNWconn/ldap/log/radius.log

-m mapping_file

P

Specifies theadius.mapping file used by the dsradiusd daemon.

Specifies that the server will accept all zeros in the authenticator that is passed
between the NAS and the RADIUS server. This allows compatibility with NAS
devices that support older versions of the RADIUS protocaol.

authentication_udp_port

Specifies the UDP port on which the authentication process déthdiusd
daemon is started. The default port number for the authentication prodéths
Due to later standardization, the standard port numBde1i2

-P accounting_udp_port
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Specifies the UDP port on which the accounting process afstlagliusd
daemon is started. The default port number for the accounting prodégsis
Due to later standardization, the standard port numide31i3
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dsradiusd

max_outstanding_requests

Indicates the maximum number of connection requests that can be queued. The
default is500Q

Starts thedsradiusd  daemon in single process mode for debugging.

max_seconds_in_queue
Sets the timeout on a connection request in seconds. The default &ue is

Starts thedsradiusd  daemon in verbose mode. The output is displayed on
screen.
trace-level

Specifies a trace level for the dsradiusd daemon. When the daemon is running
with this option, it does not fork or dissociate from the terminal. The trace level
can be the sum of:

e 1=trace (the default)

e 2=args

e 4=config

e 8=mapping
e 64=memory
min_threads

Specifies the minimum number of threads used bydshediusd daemon to
process connection requests. The default valBe is

-Z

max_threads

Specifies the maximum number of threads used bygshediusd daemon to
process connection requests. The default valié2d

See Also

See “dsradiusd.conf” on page 132
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dsradiusd.conf

Synopsis

The location of thelsradiusd.conf file is:

letc/opt/SUNWconn/Idap/default/dsradiusd.conf

Description

Thedsradiusd.conf file contains configuration parameters for the RADIUS
service. The configuration parameters held in this file are different from those defined
in the mapping fileradius.mapping

Thedsradiusd.conf file contains the following configuration parameters:
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LDAP_Server
Specifies the hostname of the LDAP server. The default valoeaihost

LDAP_Port

Specifies the TCP port number that the LDAP server runs on. The default value is
389

LDAP_Bind_dn

Specifies the DN used to bind to the LDAP directory for performing searches and
modifying the LDAP database. The example value provided as a placeholder in
dsradiusd.conf is cn=radiusadmin.

LDAP_Password

Specifies the password used to bind to the LDAP directory for performing
searches and modifying the LDAP database. The example value provided as a
placeholder irdsradiusd.conf is secret

LogLevel

Specifies the log level. You can select one of the following log levels:

e 0=none
e 1 =trace
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e 2 =trace and translation
e 3 =trace, translation, and other debug information

The default i.

* LogSize

Specifies the number of kilobytes before the log file automatically changes over to
the next log file. The default valuelif0Q

* LogDir

Specifies the log directory whedsradius.log is located. The default value
is /var/opt/SUNWconn/ldap/log

See Also

See “radius.mapping” on page 134, “dsradiusd” on page 128

radius.at.conf

Synopsis

The location of theadius.at.conf file is:

lopt/SUNWconn/ldap/default/schema/radius.at.conf

Description

Theradius.at.conf file contains schema information used for storing RADIUS
authentication and accounting information in the Netscape Directory Server. It
contains a list of LDAP attributes required to use the Netscape Directory Server to
store RADIUS information.

Attribute definitions in theadius.oc.conf file contain:

* The name of the attribute
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» The OID of the attribute
e The attribute syntax
» If the attribute is single valued, the keywaidgle

For example, the definition of the dictionaryFile attribute is:

attribute dictionaryFile 1.3.6.1.4.1.42.2.27.1.1.74 ces single

For information on the possible attribute syntaxes, refer to “RADIUS Attributes” on
page 93.

See Also

See “radius.oc.conf” on page 136.

radius.mapping

Synopsis

The location of theadius.mapping file is:

/opt/SUNWconn/ldap/default/mapping/radius.mapping

Description

Theradius.mapping file contains:
» Configuration parameters for the RADIUS service

* RADIUS-to-LDAP mapping information

Configuration Parameters

The configuration information stored in thedius.mapping file is at the
beginning of the file, under the section entitammon
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The following configuration variables are defined:

Max_allowed_failures

This parameter determines blocking mode. It defines the number of permitted
consecutive failures to authenticate a user based on the password provided. Any
further attempt is systematically blocked, even if the connection parameters
supplied are correct. The count is reset on first success. The default value for this
parameter ig. To disable blocking mode, set this parameté. to

When an account is blocked, you must manually reset the authFailedAccess
attribute in the remote user’s entry(to
Dynamic

This parameter determines whether dynamic accounting data is recorded in the
LDAP directory (see “Configuring Dynamic Accounting” on page 36). It can have
one of two valuesn or off. By default, dynamic accounting oéf.

Authentication_Port

The authentication port number for RADIUS processes. The default port number
is 1645 Due to later standardization, the standard port numi@&1i® This port
number is defined in thedius.mapping file but is commented out.

Accounting_Port

The accounting port number for RADIUS processes. The default port number is
1646 Due to later standardization, the standard port numi&di3 This port
number is defined in thedius.mapping file but is commented out.

Acounting_dir

The directory where accounting information is stored. The default directory is
Ivar/opt/SUNWCconn/ldap/radacct . Note that there is a typographical
error in this variable in theadius.mapping  file. Do not correct it because the
RADIUS server would be unable to read it.

Max_wait_b4_reject

This parameter defines a client timeout on a RADIUS request. It determines the
maximum time a client will wait for a response from the RADIUS server. By
default it is58 seconds.

Time_limit
This parameter defines a RADIUS server timeout on LDAP search operations. It

must bestrictly less tharthe value of thd&lax_wait_b4 reject parameter.
By default it iS50 seconds.
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Note Blocking mode and dynamic accounting settings are not taken into account when the
RADIUS search is performed on a referral server.
Mapping Information
Theradius.mapping file defines the mapping of attributes in the RADIUS
dictionary file to LDAP attributes. There is a one-to-one mapping between RADIUS
attributes and LDAP attributes. This mapping is shown in detail in Table 4.1 on page
88.
This mapping information is used by the RADIUS server when it performs LDAP
searches in the directory to check authentication information provided in remote user
connection requests. It is also used by the RADIUS server to write accounting
information into the remote user entries in the directory.
The syntax and semantics of the mapping information inmaldéus.mapping file
is described in Appendix A, “Mapping Syntax and Semantics.”
See Also
See “dsradiusd.conf” on page 132.

radius.oc.conf

Synopsis

The location of theadius.oc.conf file is:

lopt/SUNWconn/ldap/default/schema/radius.oc.conf
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Description

Theradius.oc.conf file contains schema information used for storing RADIUS
authentication and accounting information in the Netscape Directory Server. It
contains a list of LDAP object classes required to use the Netscape Directory Server
to store RADIUS information.

Object class definitions in tiradius.oc.conf file contain:

» The name of the superior object class, introduced by the kewupatior
» Alist of mandatory attributes, introduced by the keyweiglires

» Alist of optional attributes, introduced by the keywatdws

For example, the definition of the radiusServer object class is:
objectclass radiusServer
superior applicationProcess
requires
host,
sharedKey
allows
dictionaryFile,
acctattrFile,
authHostPortNumber,

acctHostPortNumber

See Also

See “radius.at.conf’ on page 133.
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setup_rad

Synopsis

The syntax of theetup_rad  script is:

Jopt/SUNWconn/Idap/sbin/setup_rad -d

Description

Thesetup_rad script initializes the RADIUS server. It registers the RADIUS
console with the Netscape Console and prompts you for all the information required
by the directory server to allow connections from the RADIUS server.

Options
-d

Undoes the setup. This option removes the RADIUS console icon from the
Netscape Console, and disables the RADIUS configuration.
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Appendix

Mapping Syntax and Semantics

This chapter describes the mapping syntax and semantics usedis.thapping
file and theradius.mapping file. The mapping syntax and semantics are
designed to provide maximum flexibility so that you can easily:

» Import information from any text file into the directory
» Adapt or create the mapping for a proprietary table in your NIS environment

If this involves modifying or creating an object class with the attributes that you need,
refer to theNetscape Directory Server Administrator's Gufdeinstructions. For
information on the default RADIUS schema, refer to “RADIUS Schema” on page 91.

This chapter contains the following sections:
» “File Structure” on page 140
* “Mapping Semantics” on page 140

*  “Mapping Syntax” on page 146
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File Structure

A mapping file is made up of a number of sections that conform to the following
pattern:

Front-end name

Common
Table
Common
Dynamic
Export
Extract
Condense
Build
Import
Extract
Condense
Build

The content and meaning of each section is described in “Mapping Semantics” on
page 140. The syntactic rules for each section are described in “Mapping Syntax” on
page 146.

Mapping Semantics

This section describes the meaning of the information held in each portion of a
mapping file.

Front-end nameéndicates the name of the service. All the information that follows
that name describes the mapping of service-specific information to LDAP object
classes and attributes.

The firstCommonsection immediately following the front-end name gives
configuration information that applies to the front-end or service. It contains
mandatory configuration variables that are required in the translation process, and
optional configuration variables that are stored in the same file for convenience.
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The Tablesection provides a mapping definition for a particular type of information.
The mapping definition determines the object class of all entries created using that
particular definition. Each table definition is composed of the following sections:

«  Common

» Dynamic (mandatory)
* Export

* Import

The Dynamic section is the only one that is mandatory. Without it, neither import nor
export operations work. The other sections can be omitted if you do not need them.
For instance, if you never intend to export information from the directory, you do not
need to create an Export section.

Each section contains keywords and definitions used in the import or export process.
Table A.1 provides a list of mapping keywords, the sections in which they can occur,
and their purpose.

In any section, you can create variablesakensthat is, private definitions, by using
the following format:

tokenT =t oken definition

Your private definitions can use the syntax and functions described in “Condense” on
page 148.

Table A.1 Summary of Mapping File Keywords
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Section Keyword
Common BASE_DN
MAP_NAME

Mandatory/Optional Purpose

Mandatory, but can be specifi€pecifies a subtree. See

in the Dynamic section “BASE_DN" on page 143.

Mandatory for an NIS table Indicates the name of the NIS

definition table corresponding to the table
definition. See “MAP_NAME”"
on page 143.

PRIVATE_OBJECTCLAS®andatory when object classlissed for updates on entries

ES

Dynamic ALL_FILTER

DC_NAMING

LINE

MATCH_FILTER

Export/Build LINE
NIS_KEY
NIS_VALUE

Import/Extract LINE
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not unique created from several table
definitions. See
“PRIVATE_OBJECTCLASSE
S” on page 143.

Mandatory Defines a filter for identifying
all entries created using the
table definition. See
“ALL_FILTER” on page 144.

Optional Defines the mechanism for
converting a domain hame to an
LDAP dc name structure. See
“DC_NAMING” on page 145.

Mandatory Defines decomposition of input
information. See “LINE” on
page 144.

Mandatory Defines a filter for identifying a

particular entry created using
the table definition. See
“MATCH_FILTER” on page

144,

Mandatory if the Export sectidim export file, defines format of

exists line composed of LDAP
attributes. See “LINE” on page
144,

Mandatory for NIS Identifies NIS key in export
file.

Mandatory for NIS Identifies NIS value in export
file.

Mandatory if the Import sectioDefines decomposition of input

exists information. See “LINE” on
page 144.
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Common Section

The Common section contains definitions of variables that apply to all the entries
created using that table definition but not to the entire service or front-end. For
example, the Common section typically contains the subtree under which the entries
are created. The subtree is specified usind3th®E_DNkeyword.

BASE_DN

The BASE_DNkeyword specifies the naming context under which the entries are to
be created. Thdsimport utility looks for this parameter in several places, in the
following order:

e« Command line oflsimport , option-V
* Dynamic section
» Common section for the Table

» Common section for the Front-End (at the beginning of the mapping file)

MAP_NAME

The MAP_NAMEeyword specifies the name of the NIS map corresponding to the
table definition. This keyword is used to create administrative entries for the NIS
service. The directory server maintains these entries automatically.

This keyword is used also to create the subtree for the NIS entries that are created by
using the generic mapping definition.

The MAP_NAMEeyword is specific to the NIS service.

PRIVATE_OBJECTCLASSES

The PRIVATE_OBJECTCLASSER&eyword specifies an object class when the

object class and attributes derived from a table definition do not make up a complete
entry. This keyword is necessary for maintaining directory entries that are created
from several table definitions. This can be the case when several table definitions each
create an auxiliary object class and its associated attributes.
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For example, in the NIS environment, network hosts can have entries in at least three
files: /etc/bootparams , letclethers , letc/hosts . However, each host

has just one entry in the LDAP directory, with the three auxiliary object classes
bootableDevice, ieee802Device, and ipHost. If the entry for the host is deleted in one
of these files, the corresponding entry in the LDAP directory must not be deleted but
simply updated by removing the appropriate auxiliary object class, and any attributes
specific to that object class.

Dynamic Section

The Dynamic section contains equations that make it possible to dynamically build
the filters required to locate relevant information.

LINE

TheLINE keyword is necessary to define how the input information must be
dynamically decomposed to provide the elements required MAT&CH_FILTER
andALL_FILTER definitions.

The syntax of th&INE keyword is given in “Extract” on page 147.

MATCH_FILTER

TheMATCH_FILTERkeyword specifies a filter that is used by tth&mport  utility
to check whether an entry already exists in the database before creating it. If it exists,
thedsimport  utility will check whether it needs to be modified.

The MATCH_FILTERkeyword is also used by the directory server to respond to
commands such ggpmatch .

ALL_FILTER

TheALL_FILTER keyword specifies a filter that is used by tisexport

command to regenerate the file from which the directory entries were originally
created. This filter is necessary even if you do not intend to export information from
the directory to regenerate the source file for that information.

TheALL_FILTER keyword is used by the directory server to retrieve from the
directory all entries that belong to a given NIS table.

TheALL_FILTER keyword is also used by the directory server to respond to
commands such agcat .
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DC_NAMING

TheDC_NAMINGeyword defines the mechanism applied to convert a domain hame
of the form airius.com to an LDAP data store suffix or subtree of the form dc=airius,
dc=com. This is useful if the naming structure that you use in your directory is a
domain component (dc) structure.

Export Section

The Export section provides the method for regenerating a source file from LDAP
directory entries. This section is optional. When it exists, it must contain the keyword
LINE . TheLINE keyword in the Export section must reflect the format of a line in
the original source file.

The Export section contains the following subsections:

+ Condense
This optional subsection contains variable definitions that can be used in the Build
subsection to build the parameters required to genielfdte.

* Build
Contains at least the outdutNE definition.

In thenis.mapping file, the Build subsection defines the rules for constructing an

NIS key/NIS value pair; it also defines the rules for generating the line in the NIS file
corresponding to the LDAP directory entry.

Import Section

The Import section provides the method for translating a line in an input file into an
LDAP directory entry. This section must contain a LINE keyword that defines how a
line in the input file can be decomposed into elements that can be described by LDAP
attributes. It must also contain the list of LDAP attributes that are created from a line
in the input file.
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The Import section contains the following subsections:

» Extract
Contains the_ INE definition with the notation described in “Extract” on page
147.
« Condense
Contains variable definitions that can be used in the Build subsection to generate
LDAP attributes and attribute values.
e Build

Provides a list of LDAP attributes, including the object class, and defines the rules
for constructing the value of each LDAP attribute from the variables in the
Condense section or from the parameters in the Extract section.

In thenis.mapping file, theLINE definition in the Extract subsection specifies the
rules for analyzing a line in an NIS source file into smaller units of information called
NIS tokens.

Mapping Syntax
This section describes the syntax of the variables or tokens that you can create in each

section of a table definition. The mapping syntax is described using examples from
thenis.mapping file.

Common

The variables defined in the Common section other than the keywords listed in
Table A.1 must follow this syntax:

variable-name  =value

Variables defined in the Common section contain static configuration information.
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Dynamic

The variables defined in the Dynamic section other than the keywords listed in
Table A.1 follow the same syntax as the variables defined in the Common section.
However, their values are supplied in the input to the utility (suclsiagport or
dsexport ) that uses the mapping file during its execution.

Extract

The variables defined in the Extract section define the rules for decomposing input
information into smaller units of information, called tokens, that can be directly
mapped onto LDAP attributes, or that require simple processing in order to be
mapped onto LDAP attributes.

The syntax of a variable that defines a decomposition into tokens is:

VARIABLE => $elementl separator $element2 [ separator $elementn. Al

The separator between tokens is the separator expected in the input information. It
could be white space, a comma, a colon or any other character. However, one space in
the line definition will match any number of spaces or tabs in the actual input

information. You can specify several alternatives for the decomposition, by using two
pipe symbols (||) to introduce each alternative rule.

The conversion process examines the rules in the order in which they are specified,
and applies the first one that matches the information it was given in input.

For example, imis.mapping , the following definition extracts tokens from a line
in thebootparams file:

LINE =>$ipHostNameT $parametersT

In this example, the tokens parametersT and alllpHostAliasesT require further
processing before they can be mapped onto LDAP attributes. The processing required
is defined in the Condense section.

Thehosts file provides a slightly more complex example:

LINE =>$dummy $ipHostNumberT $ipHostNameT
$alllpHostAliasesT*#$descriptionT* || $dummy $ipHostNumberT
$ipHostNameT $alllpHostAliasesT || $dummy $ipHostNumberT $ipHostNameT
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In these examples, the tokens parametersT and alllpHostAliasesT require further
processing before they can be mapped onto LDAP attributes. The processing required
is defined in the Condense section.

Condense

The Condense section contains variables that define operations on tokens resulting
from the Extract section, or any previously defined variable in the table definition. It
simplifies the attribute value definitions given in the Build section.

Variables defined in the Condense section can contain:
» A token specified in the same table section.

» A configuration variable specified in the Common section for the same NIS table,
or in the Common section that applies to all NIS tables.

« A constant expression.

» Afunction:exclude ,getrdn ,split ,instances2string ,
string2instances ,ortrim . A variable can contain just one function. If you
want to use several functions on the same information, you must create
intermediate variables.

Variables in the Condense section can be made up of several alternative rules. The
conversion process applies the first rule that matches the input information. The rules
must be separated by two pipe symbols, and must all be part of the same expression.
For example, the following expression is permitted:

fifi=$parameterl - $parameter2 || $parameterl || juju

whereas, the following expression is not:

fifi=$parameterl - $parameter2
fifi=$parameterl
fifi=juju

You can define any number of variables in the Condense section. The order in which
they are listed is important if you create dependencies between them. For instance,
you can have:

fifi=$parameterl - $parameter2 || $parameterl || juju
riri=$fifi - $parameterA
loulou=%fifi - $parameterB
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split  Function

The syntax of theplit  function is as follows:

variableA =split(  string ," separator "," add_prefix "," add_suffix ", order )

Where:
variableAidentifies the variable

string identifies the unit of information, variable or parameter, to which the
operation applies

separatorindicates where to split the information. This value must be specified
between quotes because it could contain a space.

add_prefixspecifies a prefix to add to each item resulting from the split. This
value must be specified between quotes because it could contain a space.

add_suffixspecifies a suffix to add to each item resulting from the split. This value
must be specified between quotes because it could contain a space.

order specifies the order in which the items resulting from the split are to be
presented. The possible values for this parametdefé2eight or right2left.

For example, in thais.mapping file, the following variable definition is used to
split an NIS domain name into a sequence of LDAP domain component attributes:

DC_NAMING=split($DOMAIN_NAME, ".", "dc=", ",", left2right)
If the domain name specified is eng.europe.airius.com, the resulting expression is:

dc=eng, dc=europe, dc=airius, dc=com.

string2instances Function

Thestring2instances function breaks down a specified string into instances.
The syntax for this operation is:

variableA  =string2instances(" string “," separator ")

Where:

variableAidentifies the variable.

string identifies the unit of information, variable, or parameter to which the
operation applies. This value must be specified between quotes because it could
contain a space.

separatorindicates where to split the information. This value must be specified
between quotes because it could contain a space.
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For example, imis.mapping , the following definition in the Condense section of
thebootparams file breaks down a string of parameters into separate instances:

bootParameterT=string2instances($parametersT," ")

Thestring2instances function is also used to specify the inheritance tree for an
object class. For example, if the object class of an entry created using a particular
mapping definition is organizationalPerson, the Condense section of the mapping
definition must contain the line:

objectClassT=string2instances("top person organizationalPerson", " ")

instances2string Function

Theinstances2string function combines several instances into a single string.
The syntax for this operation is:

variableA =instances2string( instance ," separator ")

Where:

variableAidentifies the variable.
instanceis a discrete element vériableA.

separatormarks the separation between the elements of the variable. This value
must be specified between quotes because it could be a space.

For example, you could use the following variable to find the list of names and alias
names for a given machine:

NameList=instances2string($cn, " ")

If the cn attribute has the values camembert, Cam, Bertie, the resulting string would
be:

camembert Cam Bertie

trim  Function

Thetrim function removes any unnecessary white space surrounding a parameter.
The syntax for th&rim operation is:

variableA =trim( parameter )

Where:
variableAidentifies the variable
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parameteris the item from which white space must be removed

For example, if you decompose an alias list into its constituent members, you could
define the following variables:

aliasMember=string2instances($aliasList, ",")

trimAliasMember=trim($aliasMember)

Each aliasMember parameter resulting fromsneg2instances operation is
processed to remove any white spaces.

getrdn Function

Thegetrdn function returns the naming attribute of an entry, that is the attribute
used in the entry’s RDN. The syntax for tiedrdn  operation is:

variableA  =getrdn()
Note Thegetrdn function can only be used in variables in the Condense section.

For example, the cn attribute of a machine has the values camembert, Cam, Bertie, but
the actual system name of the machine, used in the RDN is camembert. For example,
you could create the following variable:

HostName=getrdn()
Thegetrdn function returns the name camembert.

Note Thegetrdn function is case-sensitive.

exclude Function

Theexclude function removes a value from a list or a string. The syntax for this

operation is:
variableA =exclude( string, exclude-value ," separator ")
Where:

variableAidentifies the variable
string identifies the list or string
exclude-valués the value to exclude

separatormarks the separation between the elements of the list or string. This
value must be specified between quotes because it could be a space.
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Note

For example, to obtain the list of aliases for a machine, you need to exclude the
canonical name from the list of names. You could create the following variables:

NamelList=instances2string($cn, " ")
HostName=getrdn()
HostAliases=exclude(NamelList, HostName, " ")

In nis.mapping , the Condense section of thests mapping definition contains:

ipHostAliasesLineT=exclude($alllpHostAliasesT,$ipHostNameT, " ")

This definition excludes the ipHostName from the list of alias names for the host.

Build

The Build subsection contains a list of LDAP attributes and the definitions of their
values. It must contain at least all mandatory attributes for an object class, and the
DN. If the DN definition is missing from the Build section, the entries cannot be
created in the directory.

You do not need to specify a DN definition in the Build sections of the
radius.mapping file because this file is not used to import entries into the
directory.

Attribute value definitions can be made up of:
« Avariable or keyword specified in any of the sections of the table definition

» A configuration variable specified in the Common section that applies to all the
tables in the Front-End section

* A constant expression
» A concatenation of any of the above

The syntax of an LDAP attribute and its associated value definition in the Build
section is as follows:

LDAPattribute  =attributeValueDefinition
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For example, if you wanted to create an entry for a mail alias, and use the LDAP
attribute rfc822mailMember to store the names of alias members, your mapping
would contain the following definitions:

Condense:
aliasMember=string2instances($aliasList, ",")
trimAliasMember=trim($aliasMember)

Build:
rfc822mailMember=$trimAliasMember

Chapter A, Mapping Syntax and Semantit5§3
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A

access
temporary 28, 30, 31
through specified NAS 30, 31
access control rules
Deja 49
access denial 24, 135

accounting
dynamic 36

accounting log
RADIUS 16

Accounting_Port parameter 25, 135

accSessionld attribute 95

acctattr file 37
default 39
location 111
reference 111

acctattrFile attribute 94
acctAuthentic attribute 94
acctDelayTime attribute 94
acctinputOctet attribute 94
acctinputPacket attribute 95
acctOutputOctet attribute 95
acctOutputPacket attribute 95
acctSessionTime attribute 96
acctStatusType attribute 96
acctTerminateCause attribute 96
Acounting_dir parameter 25, 135
ALL_FILTER keyword 144

attribute
acctattrFile 94
acctAuthentic 94
acctDelayTime 94

acctlnputOctet 94
acctinputPacket 95
acctOutputOctet 95
acctOutputPacket 95
acctSessionld 95
acctSessionTime 96
acctStatusType 96
acctTerminateCause 96
assigning a value 58
authCalledStationld 96
authCallingStationID 96
authFilterld 97
authHostPortNumber 97
authHostPortType 97
authLoginService 97
authNASidentifier 97
authPortLimit 98
authPrefixName 98
authReplyMessage 98
authServiceProtocol 98
authStartMenuld 98
authState 99
authStopMenuld 99
authSuffixName 99
authTerminationAction 100
authType 99
chapPassword 100
deleting a value 59
dictionaryFile 100
dynamiclPaddress 101
dynamiclPaddressBinding 100
dynamicSessionCounter 101
dynamicSessionid 101
expirationDate 101
framedCompression 102
framedIPaddress 102
framedMTU 102
framedProtocol 102
framedRoute 102
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framedRouting 103
grpCheckinfo 103
grpReplyinfo 103
idleTimeoutNumber 103
ipLoginHost 104
ipLoginPort 104
ipxNetworkNumber 104
modifying a value 59
pamServiceName 104
radiusAuthFailedAccess 105
radiusLoginExpiration 105
radiusLoginPasswd 105
radiusLoginProfile 105
radiusPppExpiration 106
radiusPppPasswd 106
radiusPppProfile 106
radiusServerFlags 106
radiusServerRealm 106
radiusSlipExpiration 107
radiusSlipPasswd 107
radiusSlipProfile 107
sessionTimeoutNumber 107
sharedKey 108
userCallbackld 108
userCallbackNumber 108
userid 108

userPassword 109

attribute syntax 93

attributes
dynamic accounting 36
selecting 58

authCalledStationld attribute 96
authCallingStationld attribute 96

authentication
PAM module 19

Authentication_Port parameter 25, 135
authFilterld attribute 97
authHostPortNumber attribute 97
authHostPortType attribute 97
authLoginService attribute 97
authNASidentifier attribute 97
authPortLimit attribute 98
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authPrefixName attribute 98
authReplyMessage attribute 98
authServiceProtocol attribute 98
authStartMenuld attribute 98
authState attribute 99
authStopMenuld attribute 99
authSuffixName attribute 99
authTerminationAction attribute 100
authType attribute 99

B

BASE_DN keyword 143
blocked accounts search 69
blocking mode 24, 135

C

chapPassword attribute 100

command
dejasync 121, 122

commands
dsnmpcfg 124
ypcat 144
ypmatch 144

complex searches 73

configuration
dynamic accounting 36
RADIUS server 24, 26

configuration files
dsradiusd.conf 24
radius.mapping 24

configuration parameter
Accounting_Port 25, 135
Acounting_dir 25, 135
Authentication_Port 25, 135
Dynamic 25, 135
Max_allowed_failures 24, 135
Max_wait_b4 reject 25, 135
RADIUS 24
Time_limit 25, 135



configuration parameters
RADIUS 26

connection properties 52
conventions, in this book 14
copy operation 62

copying an entry
from the View window 56

create parameters
Deja.properties file 83

creating an entry 56
selecting attributes 58

crypt syntax 118
cut operation 62

D

daemons

dsnmprad 125

dsradiusd 128
DC_NAMING keyword 145
Deja 46, 53, 54

access control rules 49

connecting to another server 54

connection properties 52
copying an entry 62
creating an entry 56
cutting an entry 62
deleting an entry 60
display options 51
general parameters 77
host name 53

logging in 49

modifying an entry 64
new window, opening 53
pasting an entry 63

port number 53
properties 51
reconnecting to server 53
renaming an entry 64
reset operation 64
restoring an entry 63
search results 75
searching for an entry 66

selecting attributes 58

starting 48

toolbar icons 46

user properties 52

View window 55

viewing an entry 55
Deja.properties file

adding a RADIUS search 81

create parameters 83

general parameters 77

location 112

RADIUS profiles 84

reference 112

dejasync command 122
reference 121
syntax 121

delete operation 60

dictionary file 34
default 35
internal server attributes 35
location 123
reference 123
specifying 35
dictionaryFile attribute 100

dsnmpcfg command
reference 124
syntax 124

dsnmprad daemon 39
reference 125
syntax 125

dsradius script
reference 127
syntax 127

dsradiusd daemon 21
reference 128
syntax 128

dsradiusd.conf file 24
location 132
reference 132

dynamic accounting 25, 135
attribute
creating 38
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attributes 36 framedIPaddress attribute 102

exﬁmple;e, 37 framedMTU attribute 102
enabling .
parameters 37 framedProtocol a'ttnbute 102

RADIUS 36 framedRoute attribute 102
Dynamic parameter 25, 135 framedRouting attribute 103
dynamiclPaddress attribute 101
dynamiclPaddressBinding attribute 100 G
dynamicSessionCounter attribute 101 getrdn function 151
dynamicSessionld attribute 101 mapping 151

grpCheckinfo attribute 103

E grpReplyinfo attribute 103
entry 55

copying 62 H

cutting 62 host name 53

deleting 60

highlighting 56

naming 57 |

pasting 63 icons 46
entry modifying idleTimeoutNumber attribute 103

assigning attribute values 58 s

initialization

deleting attribute values 59
modifying attribute values 59

entry renaming 64
environment variable

RADIUS server 21
instances2string function 150
int syntax 118

JAVA_HOME 49 internal attributes 35
exclude function 151 ipaddr syntax 118
expirationDate attribute 101 ipLoginHost attribute 104
ipLoginPort attribute 104
F ipxNetworkNumber attribute 104
files
acctattr 111 J
Deja.properties 112 JAVA_HOME environment variable 49

dictionary 123

dsradiusd.conf 132

radius.at.conf 133 K

radius.mapping 24, 134 kevwords

radius.oc.conf 136 r)1/1apping 141
fonts, in this book 14

framedCompression attribute 102
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L

LINE keyword 144

list LOGIN users search 71
list PPP users search 69
list SLIP users search 70

log
RADIUS accounting 16

logging in
Deja 49
login name search 68

M

MAP_NAME 143
MAP_NAME keyword 143
Mapping
RADIUS/LDAP 88
mapping 143
ALL_FILTER 144
BASE_DN 143
DC_NAMING 145
exclude function 151
extending 90

instances2string function 150

keyword summary 141
LINE 144, 145
MATCH_FILTER 144

PRIVATE_OBJECTCLASSES 143

RADIUS/LDAP 88
split function 149

string2instances function 149

trim function 150
mapping file
Common section 143
Condense section 148
Dynamic section 144, 147
Export section 145
Extract section 147
Import section 145
radius.mapping 87
semantics 140
structure 140

syntax 146
MATCH_FILTER keyword 144
Max_allowed_failures parameter 24, 135
Max_wait_b4_reject parameter 25, 135

modify operation 64
cancel 64

N
naming
RADIUS entry 57
nis.mapping file
synchronization 122

O

object class
radiusServer 93

P

PAM module 19
pamServiceName attribute 104

parameters
dynamic accounting 37
RADIUS configuration 24, 26

paste operation 63
port number 53
PRIVATE_OBJECTCLASSES keyword 143

properties
Deja 51

R

RADIUS
accounting log 16
attributes 34
blocking mode 24, 135
dictionary file 34
dynamic accounting 36
attributes 36

RADIUS access
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temporary 28, 30, 31

through specified NAS 30, 31

virtual domain 32

RADIUS accounting 16

monitoring 41
RADIUS authentication

monitoring 40
RADIUS configuration

files 24

parameters 24, 26
RADIUS entry

search 66

search results 75

searching 66
RADIUS functions

naming an entry 57
RADIUS profiles

Deja.properties file 84

RADIUS schema 91

RADIUS searches
processing order 33

RADIUS server 13
configuration 24, 26
initialization 21
internal attributes 35
statistics 39

RADIUS statistics
displaying 42
radius.at.conf file
location 133
reference 133

radius.mapping file 24, 87
location 134
reference 134
synchronization 122
virtual domains 32

radius.oc.conf file
location 136
reference 136

RADIUS/LDAP mapping 88
extending 90
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radiusAuthFailedAccess attribute 105

radiusLoginExpiration attribute 105
radiusLoginPasswd attribute 105
radiusLoginProfile attribute 105
radiusPppExpiration attribute 106
radiusPppPasswd attribute 106
radiusPppProfile attribute 106
radiusServer object class 93
radiusServerFlags attribute 106
radiusServerRealm attribute 106
radiusSlipExpiration attribute 107
radiusSlipPasswd attribute 107
radiusSlipProfile attribute 107

RAS entry
searching 72

RAS IP address search 73
RAS name search 72
reconnecting Deja 53

refresh
Deja 54

refreshing display 54

remote user
searching 67

rename operation 64
reset operation 64
restore operation 63

S

schema 91

scripts
dsradius 127
setup_rad 138

search
parameters 81

search operation 66
RADIUS entry 66
search results 75



searching

blocked accounts 69

complex search 73

login name 68

LOGIN users 71

PPP users 69

RAS
IP address 73
name 72

RAS entry 72

RAS IP address 73

RAS name 72

remote user 67
blocked accounts 69
list LOGIN users 71
list PPP users 69
list SLIP users 70
login name 68
user name 68
user name and mail 71

SLIP users 70

user name 68

user name and mail 71

sessionTimeoutNumber attribute 107

setup_rad script
reference 138
syntax 138

sharedKey attribute 108

SNMP agent
dsnmprad 39

split function 149

statistics 39
accounting service 41
authentication service 40

string syntax 118
string2instances function 149
styles, in this book 14

synchronization
nis.mapping file 122
radius.mapping file 122

syntax
crypt 118

int 118

ipaddr 118

of LDAP attributes 93
string 118

T

temporary access 28, 30
terms, in this book 14
Time_limit parameter 25, 135
timeout 25, 135

trim function 150

U

user name and mail search 71
user name search 68

user profile
selecting 52

user properties 52
userCallbackld attribute 108
userCallbackNumber attribute 108
userid attribute 108
userPassword attribute 109

Vv

View window
closing 55
copy entry 56
displaying 55
highlighting an entry 56
viewing 55
viewing an entry 55
virtual domain 32

w

window, closing 53
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Y

ypcat command 144
ypmatch command 144
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